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Claris’ liability to you for actual damages for any cause whatsoever, and regardless of the form of the action, will be limited to the greater of $500 or

the money paid for the Software that caused the damages.  

THE ABOVE LIMITATIONS WILL NOT APPLY IN CASE OF PERSONAL INJURY ONLY WHERE AND TO THE EXTENT THAT
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LIMITATION OF IMPLIED WARRANTIES OR LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE
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Welcome to Claris Emailer

This user’s guide introduces you to the Claris Emailer™ application from 
Claris Corporation. Claris Emailer is an electronic mail manager program for 
the Macintosh. With Claris Emailer, you can:

1 send and receive messages and files using America Online, CompuServe, 
eWorld, an Internet mail server, or RadioMail

1 schedule automated connections to online services, which can reduce 
costs by connecting during off-peak hours

1 quickly change the local access numbers and connection information you 
need to use when you travel

1 store sent and received messages and files

1 keep an address book of individuals or groups. You can also import 
addresses directly from your existing address books

1 automatically file, prioritize, reply to, or forward messages received from 
a certain sender or that contains specific text

Customer support and registration
Please take the time to complete and mail the postage-paid product 
registration card for your new software, or call (800) 356-6657 to register by 
phone. For information about customer support, refer to the Claris® Service 
Directory included in the product package. You can also receive support 
information by sending an electronic message with Emailer in the subject 
line to info@claris.com or contacting the Claris Emailer support team at 
emailer-help@claris.com.

Using this user’s guide
This book provides instructions for installing and using Claris Emailer. 

Chapter 1 explains how to install Claris Emailer on your hard drive and to 
set up the account and service information needed to send and receive mail.

Chapter 2 gives an overview of Claris Emailer. If you are new to electronic 
mail applications, be sure to read this chapter. If you are familiar with other 
electronic mail applications, this chapter will help you quickly understand 
how to use Claris Emailer.
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Chapters 3 and 4 explain how to create, address, send, receive, file, and print 
mail messages and add addresses to the Address Book.

Chapter 5 explains how to use mail actions to automatically file, prioritize, 
reply to, and forward the mail you receive.

Chapter 6 describes how to configure Claris Emailer by adding or changing 
schedules, locations, service information, and destinations. 



Chapter 1: Installing Claris Emailer

This chapter provides step-by-step instructions for installing the Claris 
Emailer application and associated files on your Macintosh. 

Important  These instructions assume that you’re familiar with standard 
mouse techniques such as clicking and dragging. If you need more 
information about mouse techniques, or working with disks, see the 
documentation that came with your Macintosh.

What your package contains
Here’s what you’ll find in the Claris Emailer package:

1 one disk (Disk 1) or CD-ROM disc containing the Installer application, 
the compressed Claris Emailer application, and other associated files

1 Claris Emailer User’s Guide, which tells you how to install, use, and 
configure Claris Emailer

1 Claris registration card

1 Claris Service Directory 

What you need
To use Claris Emailer, your system must meet the following minimum 
requirements:

1 a Macintosh II (a 68020 processor) or any later Macintosh model

1 System 7.0 or later

1 1.5 MB of available memory (RAM) to run Claris Emailer (4 MB of total 
memory recommended)

1 2 MB of disk space to install all Claris Emailer files plus 1 MB for your 
saved messages and files (you may require more disk space if you save 
many messages or large files)

1 a modem, if you connect to an online service using a phone line

You also must have the following:

1 at least one account on America Online, CompuServe, eWorld, 
RadioMail, or the Internet. Claris Emailer does not join the service for 
you. You must already have an active account.

1 if you use an Internet account, access to a mail server supporting the 
POP3 and SMTP protocols and your connection to the mail server must 
be through MacTCP.
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Installing Claris Emailer 

 

You must use the Installer program to install the Claris Emailer 
application—you can’t copy the files to your hard disk by dragging the files 
to your desktop. The files are compressed, and the Installer program 
decompresses them.

Before you begin the installation, get the following information:

 

1

 

account information for each online service that you use. This includes 
your account IDs or addresses and the passwords to access your accounts.

 

1

 

information needed to connect to each online service. This includes 
modem information, phone numbers, and other information needed to 
connect to a specific online service.

 

Note

 

Some system extensions and control panels (like virus protection 
utilities) might interfere with the Claris Emailer installer. If you want to 
disable these system utilities, start your computer and hold down the Shift 
key until you see 

 

Welcome to Macintosh. Extentions Off

 

.

To install Claris Emailer:

 

1.

 

Turn on your Macintosh or PowerBook.

 

2.

 

Place the CD-ROM disc, or the 3.5 inch disk labeled 

 

Disk 1

 

, into the 
appropriate drive and double-click the Installer icon.

You see the Claris Emailer startup screen.

 

3.

 

Click 

 

Continue.

 

You see the Claris Emailer Installer dialog box.

1-01

Leave as Easy Install to install a
version that runs on any Macintosh, or

select Custom Install to install for a
specific Macintosh or RadioMail

network support

Click to select a 
different disk or folder 
for the installation 
location

Disk where Claris Emailer
will be installed

Click to see additional 
information about Claris 
Emailer
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4.

 

Click 

 

Install

 

. 

The Installer begins copying files. A dialog box tells you what the 
Installer is doing. After all the files are installed, a final dialog box tells 
you the installation on your hard disk was successful. 

 

5.

 

Click 

 

Quit

 

. 

You see the opened Claris Emailer Folder on your desktop. You now go 
through a brief, one-time setup of the accounts and services you use. You 
can also set up a connections schedule. You cannot use Claris Emailer to 
send or receive mail until you’ve entered account and service information. 

 

6.

 

Double-click the Claris Emailer icon.

You see the Personalize dialog box, where you enter your name, company 
name (if applicable), and software serial number.

 

7.

 

Type your name, company name, and serial number, pressing Tab 
between each one. Then, click 

 

OK

 

.

You see the first setup screen.

The initial setup can get you using Claris Emailer quickly. You can 
always change or add to your initial settings later. 

If you would rather use the Setup menu to enter more customized setup 
information, click 

 

Done

 

. For more information about configuring Claris 
Emailer, see chapter 6, “Configuring Claris Emailer.”

 

8.

 

To step through the setup screens, click 

 

Next

 

. 

1-03
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Follow the directions on each screen. See the next sections for 
information about what you’ll enter on the setup screens. When you finish 
the last screen, click Done.

When you finish the initial setup, you see a dialog box asking if you want 
to check your mail now.

9. If you want to receive email now, click Yes. Otherwise, click No.

Note If you clicked Yes and entered more than one service, you see the 
Connect Now Setup dialog box. Click next to the services you want to use 
to recieve your messages and click Connect. For more information, see 
“Connecting to a service” on page 3-1.

Setting up Internet accounts
The following table describes entries you see when setting up Claris Emailer 
for an Internet account.

Setting up CompuServe accounts
The following tables describe entries you see when setting up Claris Emailer 
for a CompuServe account. 

In this text box Type

POP account The full address of your POP account. Generally, it’s the 
Internet address that people use to send you mail (for 
example, your_name@host.domain).

POP password The password you use to access your email

SMTP server The name of your mail server. This is usually the host 
domain. Ask your network administrator if you are 
unsure of your SMTP server name.

Return address The address for replies you want sent to a different 
address. Otherwise, leave this entry blank.

In this text box Type

Phone number The local phone number you call to connect to the 
service. Include all numbers you use when dialing 
manually, such as 9 for an external line or 1 for a long 
distance prefix.

Retries The number of times to try reconnecting to the service if 
a connection error occurs 

User ID Your account user identification number

Password The password for your account
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Click Speaker on if you want to hear the modem connect.

Setting up America Online and eWorld accounts
The following table describes entries you see when setting up Claris Emailer 
for America Online and eWorld accounts.

Click Configure to enter the connection settings for America Online or 
eWorld. This usually includes the phone number, modem type, and baud 
rate, depending on the connection tool you use.

Setting up RadioMail accounts
The following table describes options you see when setting up Claris 
Emailer for a RadioMail account.

From this pop-up menu Choose

Modem type The kind of modem you use. If your modem is not in the 
pop-up menu, leave the setting as Hayes.

Baud rate The baud rate of your modem. If you are unsure of the 
rate, try using 2400.

Network The network that you use to connect to the service. This 
is usually the CompuServe network.

For this text box or pop-up menu Do this

Screen name Type your account screen name.

Password Type the password for your account.

Network Choose the network that you use to connect to the 
service from the pop-up menu. This is usually AOLnet 
or the Sprint network for America Online and the Sprint 
network for eWorld.

In this text box Type

Account ID Your RadioMail account name

Return Address The address for replies you want sent to a different 
address. Otherwise, leave this entry blank. 
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When you’re finished installing
When you finish installing Claris Emailer, setting up your accounts, and 
optionally gathering your mail, the Browser opens to the In Box. If you are 
ready to start using Claris Emailer, you can now send, receive, print and file 
your mail. However, if you turned off extensions before installing, you may 
want to quit Claris Emailer and restart your computer. To quit, choose Quit 
from the File menu.

What gets installed on your hard disk
The Installer creates and places files into the Claris Emailer Folder. (The 
installer also places files, if you need them, in the System Folder.) When you 
set up and use Claris Emailer, other folders and files are also created. The 
following illustration shows where Claris Emailer places folders and files.

Note If you use System 7.5 or later, the Macintosh Drag and Drop and the 
Thread Manager files are are built into your system. For a description of the 
mail folders, see “Setting up folders in the Filing Cabinet” on page 3-17.

1-05
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Removing Claris Emailer from your hard disk
To remove Claris Emailer and its associated files from your hard disk:

1. Drag the Claris Emailer Folder to the trash can.

If you saved messages that you don’t want thrown away, make sure to 
remove them from the folders in the Filing Cabinet first.

2. Drag the Claris Emailer Preferences file from the Claris folder to the 
trash can.

If you moved Claris Emailer from its original folder, you also need to locate 
the original folder and put that folder in the trash can.



 

Chapter 2: Claris Emailer basics

 

This chapter provides an overview of Claris Emailer, giving you the basic 
information you need to get started using the product. If you want more 
detailed information on any of the concepts presented in this chapter, see 
chapters 3-6 and appendixes A-C.

 

Starting Claris Emailer

 

To start Claris Emailer, double-click the Claris Emailer Folder to display its 
contents, and then double-click the Claris Emailer 1.0 icon. If you file a 
message in a folder or on the desktop (see “Filing messages” on page 3-16), 
you can also start Claris Emailer by double-clicking the message.

 

Getting around

 

When you open Claris Emailer, you see the Browser, which is where you 
send, receive, address, and file mail messages. You can close the Browser 
while you work in other applications, and open it to check incoming mail. To 
close the Browser, click its close box or choose 

 

Close

 

 from the File menu. To 
reopen the Browser, choose 

 

Browser

 

 from the Window menu. 

To switch to a different area of the Browser, click a tab or choose 

 

In Box

 

, 

 

Out Box

 

, 

 

Filing Cabinet

 

, or 

 

Address Book

 

 from the Window menu. 

 

Tip

 

To set which area of the Browser you see when you open Claris Emailer, 
choose 

 

Preferences

 

 from the Setup menu. Then click the 

 

General 

 

tab, select 

 

Open Browser to

 

, and choose an option from the pop-up menu. (If you want 
to open Claris Emailer with the Browser hidden, deselect 

 

Open Browser to

 

.)
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You can sort and resize columns in any area of the Browser.

 

 

 

Connecting to services

 

You send and receive mail by 

 

connecting

 

 to one or more online services, 
such as eWorld or CompuServe. You can connect immediately, or set up 
regularly scheduled connections. To connect right away, choose 

 

Connect Now

 

 
from the Mail menu. To schedule a connection, choose 

 

Schedules

 

 from the 
Setup menu. (Then double-click a schedule to change it, or click 

 

Add

 

 to 
create a schedule.)

 

Important

 

You must turn on your computer and modem, and launch 
Claris Emailer for a connection to work. If you schedule a connection for a 
time you’ll be away from the computer, be sure to leave your computer and 
modem on, and leave Claris Emailer running.

 

To Do this

 

Resize a column Position the pointer over the vertical line between two column 
headings. When the pointer changes to a double arrow, drag it left 
or right until the column is the size you want. 

Sort a column Click the column heading. If a column can be sorted, the pointer 
changes to a  when you move it over the column heading. 

Change the sort order Click  or .

2-01

Click to close the Browser

Scroll to see more 
information
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Sending mail

 

To create a message, choose 

 

New

 

 from the Mail menu. You can then title and 
address the message, type the message body, and save the message to the 
Out Box.

If you want, you can enclose files from your hard disk with messages you 
send. To add an enclosure, double-click a message in the Out Box to open it, 
click the  icon, and then click 

 

Find Enclosure

 

 or 

 

Add Enclosure

 

. 

 

To Create the message and click

 

Save a message and send it at the 
next connection

 

Save

 

Save a message without sending it

 

Do not schedule

 

, and then click 

 

Save

 

Send a message immediately

 

Send Now 

 

(When you send a message using Send Now, 
the message is saved automatically.)

2-02

outgoing mail

incoming mail

America Online
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New outgoing message
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Important

 

Some commercial services do not accept enclosed files over the 
Internet. Before sending an enclosure, you may want to contact both the 
sending and receiving services to make sure they accept enclosed files.

You send messages through one or more online services on which you have 
accounts. Those services forward the message to one or more 

 

destinations

 

. 
For example, if you have an account on CompuServe, you can send a 
message to another CompuServe user, or to recipients at other destinations, 
such as the Internet.

 

 

 

Receiving mail

 

You can retrieve incoming mail from one or several services, either right 
away or at scheduled connections. Incoming mail is stored in the In Box. To 
open a message in the In Box, double-click it.

message

Danielle Bradbury

Jane Smith

Michelle Cannon

Sophie Tang

Elfriede Lechner

Kentaro Ogawa

2-03

Service

Destination Recipient
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You can reply to or forward incoming messages at any time. 

 

Setting up mail actions

 

If you receive a large number of incoming messages, use 

 

mail actions

 

 to 
prioritize, reply to, file, and forward your messages automatically.

 

To Open the message and then click

 

Reply to a message

 

Reply

 

 or choose 

 

Reply

 

 from the Mail menu

Forward a message

 

Forward

 

 or choose 

 

Forward

 

 from the Mail menu

2-04

Services In Box
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Mail actions
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Mail actions execute tasks based on criteria you specify. For example, you 
can create mail actions to:

 

1

 

set messages from your boss to Priority 1 status so that they’ll appear at 
the top of your In Box when you sort by priority

 

1

 

file messages containing specific text in the message body in a folder 
you choose

 

1

 

automatically reply to specific messages with text you prepare in advance, 
such as a note saying that you’re away and will reply upon returning

 

Setting up the Address Book

 

Use the 

 

Address Book

 

 to store addresses for individuals and groups, and to 
address messages. To open the Address Book, choose 

 

Address Book

 

 from the 
Window menu. To add an address, click 

 

New User

 

. 

You can also consolidate several addresses into a 

 

group

 

. When you send a 
message to a group, every recipient in the group receives the message. To 
create a group, click 

 

New Group

 

.

To find specific addresses in the Address Book, type a few characters in the 

 

Filter

 

 

 

text box. Claris Emailer finds only those addresses that contain the 
specified characters in the recipient’s name or description. 
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Individual address

Group address

Address with more than one
mail service (click the arrow

to show or hide additional
addresses)
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Addressing a message

 

Once you add names to your Address Book, you can use them to address outgoing 
messages. You add addresses to the address area of an outgoing message.

There are many ways to address a message. For instance, you can:

 

1

 

type addresses manually

 

1

 

drag addresses from the Address Book to the address area of the message

 

1

 

select addresses in the Address Book and then choose 

 

New

 

 from the Mail 
menu to create a pre-addressed message

 

Printing mail

 

This section covers printing incoming, outgoing, and saved messages. You 
can print one message at a time, and you must open a message to print it. 

To print a message, open the message from the In Box, Out Box, or 
Filing Cabinet, and then choose 

 

Print

 

 from the File menu. (In an incoming 
message, you can also click the 

 

Print 

 

button.) In the Print dialog box, select 
the options you want, and click 

 

Print

 

. 

To bypass the Print dialog box and print a message, choose 

 

Print One

 

 from the 
File menu. Your message prints using the default print settings.

2-10

Address area
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Filing mail

 

You can file both incoming and outgoing messages. To file a message, select 
it in the In Box or Out Box, and then click 

 

File

 

. 

In the Filing Cabinet, you can view and open filed messages. To open the 
Filing Cabinet, choose 

 

Filing Cabinet

 

 from the Window menu.

 

 

 

Using Macintosh drag and drop

 

Claris Emailer supports Macintosh drag and drop, a technology you can use to 
move items—such as addresses, messages, or enclosures—without copying 
and pasting. For instance, with Macintosh drag and drop, you can drag an 
address from the Address Book to the address area of an outgoing message. 

Macintosh drag and drop comes with System 7.5. If you are using an earlier 
system version, Macintosh drag and drop is installed automatically when 
you install Claris Emailer.

If your system has the System 7.5 Clipping Extension installed, you can also 
drag an address from Claris Emailer to your desktop to create a 

 

text clipping

 

. 
A text clipping is a file that you can drag from the desktop into another 
document, such as an outgoing message. You can rename a text clipping to 
reflect its content. 

2-07

Click a folder to see
the messages it

contains

Double-click 
a message to 
open it
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Tip  

 

You can also create a text clipping by selecting some text and dragging it 
from the body of a message to the desktop. Later, you can drag the text to 
another message, or to any application that supports Macintosh drag and drop. 

 

To drag See

 

Addresses to an 
outgoing message

“Addressing messages using Macintosh drag and drop” on 
page 3-5.

Enclosures to an 
outgoing message

“Dragging an enclosure to a message” on page 3-9.

Enclosures from an 
incoming message to 
the desktop

“Moving an enclosure using Macintosh drag and drop” on 
page 3-14.

Messages to, from, and 
within the Filing Cabinet

“Moving messages using Macintosh drag and drop” on page 3-17.

Addresses to the desktop “Dragging addresses to the desktop” on page 4-3

Addresses to a group “Adding addresses to a group” on page 4-5



 

Chapter 3: Using Claris Emailer

 

This chapter covers most of the day-to-day tasks for which you’ll use 
Claris Emailer—creating, sending, receiving, filing, and printing mail 
messages. You send and receive messages during a 

 

connection

 

 to an online 
service, such as eWorld or CompuServe. You can set up a connection to 
communicate with one service or many services.

 

Connecting to a service

 

You can connect to a service immediately or at your next scheduled 
connection. For more information on scheduling a connection, see 
“Scheduling account connections” on page 6-1. 

 

Important

 

You must turn on your computer and modem, and launch 
Claris Emailer, for a connection to work. If you schedule a connection for a 
time when you’ll be away from the computer, be sure to leave your computer 
and modem on, and leave Claris Emailer running. 

To connect to a service immediately, choose 

 

Connect Now

 

 from the Mail 
menu. If you subscribe to more than one online service, you see this 
Connect Now Setup dialog box.

3-24

Services selected to send and receive 
messages during this connection

Click next to the service(s)
you want to use to send
and receive messages
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If you subscribe to only one service, then you see this smaller dialog box.

 

 

 

Creating messages

 

To create a message from the Out Box, choose 

 

Out Box

 

 from the Window 
menu and then click 

 

Add

 

. To create a message at any time, choose 

 

New

 

 from 
the Mail menu. You see a new blank message.

 

 

 

Tip

 

To create a message that’s already addressed to your intended recipients, 
choose 

 

Address Book

 

 from the Window menu, select one or more addresses, 
and then choose 

 

New

 

 from the Mail menu.

 

To Do this

 

Retrieve incoming messages 
during the connection

Select 

 

Get.

 

Send messages during 
the connection

Select 

 

Send 

 

and

 

 

 

choose an option from the pop-up menu.

Choose 

 

Specified Msg

 

 to send an open message, or choose 

 

All Pending Msgs

 

 to send all the unsent messages in your 
Out Box.

Initiate the connection Click 

 

Connect.
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Addressing messages

 

After you create a message, you can address it by typing addresses manually, 
using the Find Address dialog box, or using Macintosh drag and drop.

When you finish addressing a message, you see the  icon next to the 
recipient’s name. If you see the  icon, your address is incomplete. If this 
happens, read this section carefully to make sure you entered all the required 
addressing information.

 

Addressing a message manually

 

To address a message manually, you type information in the address area of 
the message. To add another recipient, click 

 

Add Recipient

 

. To delete a 
recipient, click anywhere in the recipient line and then click 

 

Delete Recipient

 

. 

 

To enter the Do this

 

Recipient name Type a name in the Recipient field. As you begin typing the recipient’s 
first name, Claris Emailer fills in the rest of the name for you. Keep 
typing until Claris Emailer fills in the correct name.

If the recipient is in the Address Book, press Tab to have Claris Emailer 
automatically enter the rest of the addressing information. If the 
Address Book has two or more recipients with the same name, or if the 
recipient is a group, you see the Find Address dialog box (see the next 
section). If you inadvertently enter the wrong recipient, you can type 
over the recipient’s name and addressing information, or delete the 
recipient and add a new one.

Recipient address Type the recipient’s mail address in the Address field. 

Destination Type the name of the service that the recipient uses to retrieve mail. For 
example, type 

 

America Online 

 

if the recipient receives mail in an 
America Online account. 

As you type, Claris Emailer fills in the rest of the destination for you. 
Keep typing until Claris Emailer fills in the correct destination. (If 
you want, you can choose a destination from the pop-up menu instead 
of typing.)

If the recipient is in the Address Book, the destinations they have 
addresses for are in bold in the Destination pop-up menu. If you choose 
one of these destinations, Claris Emailer updates the Address field with 
the correct address. For more information about destinations, see 
“Routing your mail using Destinations” on page 6-13.
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Using the Find Address dialog box

 

To find recipient addresses and add them to an outgoing mail message:

 

1.

 

Create an outgoing message.

See “Creating messages” on page 3-2.

 

2.

 

Click 

 

Find Recipient

 

.

You see the Find Address dialog box. 

 

3.

 

If you want to narrow down the number of recipients in the Find Address 
dialog box, type a few letters in the 

 

Filter

 

 text box.

You can type lowercase or uppercase letters. Claris Emailer finds all the 
recipients that contain the specified letters in the Name and Description 
fields. For example, typing 

 

ja 

 

finds “Japan University” and “Jane Smith.”

 

Note

 

You cannot enter part of a first name and a last name to create a 
match. For example, entering 

 

sal will 

 

doesn’t find “Sally Willford.”

 

4.

 

Select one or more recipients. 

 

Send Mail Via 
service

Type the name of the service you want to use to send the message. For 
example, type

 

 CompuServe 

 

if you want to use your CompuServe 
account to send this message. 

As you type, Claris Emailer fills in the rest of the service name for you. 
Keep typing until Claris Emailer fills in the correct service. (If you want, 
you can choose a service from the pop-up menu instead of typing.)

 

To select Do this

 

A recipient Click anywhere on the recipient’s row.

More than 
one recipient

Shift-click the recipients you want to select. To deselect a 
recipient, or to select noncontiguous recipients, 

 

2

 

-click 
the recipients.

 

To enter the Do this

3-08

3-04

Type the letters you
want to search for
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5.

 

Click 

 

Select

 

.

If the selected address is a group, all the recipients in the group are added 
to the recipient list. 

 

Addressing messages using Macintosh drag and drop

 

You can address a message by dragging the recipients’ addresses to the 
message. The recipients’ addresses can be from the Address Book or from text 
clippings on the desktop. See “Using Macintosh drag and drop” on page 2-8. 

You can drag addresses or text clippings to either the address area of the 
message or to the icon for the address area . If you drop the addresses on 
the address area, you see a border around the address area.

To drag addresses from the Address Book to a message:

 

1.

 

Create an outgoing message.

If you need help, see “Creating messages” on page 3-2. 

 

2.

 

Choose 

 

Address Book

 

 from the Window menu.

 

3.

 

Arrange the windows so that you can see both the Address Book and the 
address area of the message.

 

4.

 

In the Address Book, select the recipients that you want to add to 
the message.

Shift-click to select more than one recipient. To deselect a recipient, or to 
select noncontiguous recipients, 

 

2

 

-click the recipients.

 

5.

 

Drag the recipients from the Address Book to the message. 

 

The recipient above 
or below the currently 
selected recipient

Press the Up or Down Arrow key.

A recipient and close 
the Find Address 
dialog box

Double-click the recipient.

A different 
destination for a 
recipient that 
subscribes to more 
than one mail service

Click the triangle next to the recipient’s name to display other 
destinations for a recipient. Then select the row containing the 
destination you want. For information on adding recipients with 
more than one address, see “Adding addresses” on page 4-1. 

 

To select Do this
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To drag addresses from the desktop to a message:

 

1.

 

Create an outgoing message.

If you need help, see “Creating messages” on page 3-2. 

 

2.

 

Arrange the windows so that you can see your outgoing message and 
the desktop.

 

3.

 

On the desktop, select the text clippings containing the addresses you 
want to add to your message.

For information on dragging addresses to the desktop to create text 
clippings, see “Dragging addresses to the desktop” on page 4-3.

 

4.

 

Drag the text clippings from the desktop to the address area of the message. 

 

Including carbon copy and blind carbon copy recipients

 

There are three types of recipients in a message. You can change a 
recipient’s type at any time by choosing an option from the Type pop-up 
menu in the address area. 

 

Important

 

You may want to check with both the sending and receiving 
services before setting up carbon copies or blind carbon copies. (Not all 
services support carbon copies and blind carbon copies.)

 

Choose When the recipient is

 

To

 

The primary recipient.

It’s best to include at least one To recipient in a message. You aren’t 
required to include To recipients.

All recipients can tell who the To recipients are. 

 

CC

 

 (Carbon Copy) Not the primary recipient, but the recipient may be interested or 
involved in the content of the message.

All recipients can tell who the Carbon Copy recipients are. 

 

BCC

 

 (Blind 
Carbon Copy)

Not the primary recipient, but the recipient may be interested or 
involved in the content of the message.

No recipient can tell whether there are any Blind Carbon Copy 
recipients. A Blind Carbon Copy recipient cannot tell whether there are 
other Blind Carbon Copy recipients.
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Enclosing files

 

You can enclose any type of file in an outgoing message using the Find 
Enclosure button, the Open dialog box, or the Macintosh drag-and-drop feature.

You enclose files by adding them to the Enclosure area of an outgoing 
message. To see the Enclosure area, click the  icon.

Before you send an enclosure, consider the following:

 

1

 

To enclose an entire folder, you must enclose each file within the folder 
separately, or use an application, such as StuffIt, to convert the folder to 
a single file. 

 

1

 

Be sure to enclose the original file and not an alias to the file.

 

1

 

Check with both the sending and receiving services before sending 
enclosures over the Internet. (Some services do not support sending and 
receiving enclosed files over the Internet.) 

 

1

 

Check with the recipient to make sure that they have the applications 
necessary to open the files you’re sending. If you save your files in text 
(ASCII) format, they can be opened in most applications that accept text.

 

1

 

If you’re enclosing a text file of less than a few pages, you may want to 
include the text in the message body instead of sending it as an enclosure.

 

Using the Find Enclosure button

 

Follow these steps to add an enclosure using the Find Enclosure button. If 
you are not already in the Enclosure area, click the  icon. 

 

1.

 

Click 

 

Find Enclosure

 

 in the Enclosure area of a message. 

 

2.

 

In the Find Files dialog box, choose the name of the disk you want to 
search from the Volume pop-up menu.

3-13 Click to hide or show
the Enclosure area

Click an icon to switch
between the Enclosure
and Addressing areas
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3.

 

Type the name (or partial name) of the file you want to search for.

 

4.

 

Click 

 

Search

 

.

 

5.

 

Select the file(s) you want to enclose.

 

6.

 

Click 

 

OK

 

.

 

Using the Open dialog box to add an enclosure

 

Follow these steps to add an enclosure using the Open dialog box. If you are 
not already in the Enclosure area, click the  icon. 

 

1.

 

Click 

 

Add Enclosure

 

 in the Enclosure area of a message. 

 

2.

 

Select a file from the Open dialog box.

 

3.

 

Click 

 

Select

 

. 
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Dragging an enclosure to a message

 

Follow these steps to add an enclosure using the Macintosh drag-and-drop 
feature. See “Using Macintosh drag and drop” on page 2-8. If you are not 
already in the Enclosure area, click the  icon. 

 

1.

 

Arrange the windows so that you can see the desktop and the Enclosure 
area of the message.

 

2.

 

From the desktop, select the files you want to enclose. 

 

3.

 

Drag the files from the desktop to the scrolling list in the Enclosure area.

As you drag the files into the message, you see a border around the 
Enclosure area. When you release the mouse, the enclosures are added to 
the message.

 

Tip

 

You can also drag enclosures to the  icon of a message.

 

Setting options for sending enclosures

 

To set the way Claris Emailer handles the sending of enclosures, select 
options from the Enclosure area of a message. 

 

Removing enclosures

 

To remove enclosures, select one or more enclosures in the Enclosure area 
of a message and click 

 

Delete Enclosure

 

.

 

To Do this

 

Compress the files 
you’re sending

Select 

 

Compress Files

 

.

You must compress files if you include more than one enclosure. 
Compressing enclosed files saves time during the transfer and can 
reduce the charges on some services. Claris Emailer uses the StuffIt 
compression technology to compress the files. The recipient of the 
message must have a StuffIt expansion tool (available from the public 
domain) to expand any compressed files. If the message is received 
using Claris Emailer, enclosures are automatically expanded. 

Set the encoding of 
compressed files

Choose an option from the Encoding pop-up menu.

Enclosed files are sent using special encoding to ensure that they 
arrive without errors. If the recipient’s destination is the same as the 
service you’re sending the message through, choose 

 

Service Default

 

, 
the optimal encoding for your service. 

If your service doesn’t support enclosures, try choosing 

 

BinHex

 

, which 
appends the enclosure as text in the message body.
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Sending messages

 

After you create a message, you can:

 

1

 

save it and send it at the next connection to a service

1 save it without sending it

1 send it immediately. (When you send a message immediately, it is 
automatically saved for you.)

You can also reply to or forward a message you receive. (See “Replying to 
a message” on page 3-14, and “Forwarding a message” on page 3-16.) 

Outgoing messages are saved in the Out Box. To open a message in the 
Out Box, double-click it.

Sending a message at the next connection
To save a message and send it at the next connection to a service, click Save. 
Claris Emailer saves your message, closes it, and stores it in the Out Box. To 
save your message without closing it, choose Save from the File menu. For 
information on setting up scheduled connections, see “Scheduling account 
connections” on page 6-1.

Saving a message without sending it
If you’re not finished composing a message, you can save it without sending it, 
and continue working on it later. To do this, select Do not schedule, and then 
click Save. Claris Emailer saves your message, closes it, and stores it in the Out 
Box. To save your message without closing it, choose Save from the File menu. 

Sending messages immediately
After you create a message, you can send it immediately. You can also 
immediately send all the unsent messages in your Out Box. 

Note You must close a message before you can send it. Clicking Send Now 
automatically closes a message before sending it.

To Do this

Save a message and send 
it immediately

Click the Send Now button at the top of the message screen. 

(The Send Now button is dimmed if you try to send a 
message while a connection is open.)

Immediately send all the unsent 
messages in your Out Box

Choose Connect Now from the Mail menu.
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After either of these actions, you see the Connect Now Setup dialog box. For 
information on setting connection options, see “Connecting to a service” on 
page 3-1. 

Checking the status of messages you send
After you save or send a message, you can check its status in the Out Box. 
To go to the Out Box, choose Out Box from the Window menu.

The icons in the first three columns show the status or give information about 
a message.

This icon Shows that the message

Will be sent at the next scheduled connection

Has been saved but will not be sent because the Do not schedule option was 
selected in the message. If you want, you can edit the message and save it 
again and/or send it.

Has been sent successfully

Has an addressing error.

This icon is also shown in the Out Box tab.

Contains one or more enclosures

Is a reply to a message you received

3-16

3-17

3-18

3-19

3-20

3-11

3-34



3-12 Claris Emailer User’s Guide

Receiving messages
This section covers reading, replying to, and forwarding messages you 
receive, and storing and opening enclosed files. 

You can immediately retrieve incoming messages from one or more online 
services, or wait until messages are retrieved automatically at the next 
scheduled connection. To retrieve messages immediately, follow the 
instructions on connecting to a service on page 3-1.

Messages you receive are stored in the In Box. When you receive a message, 
you see:

1 a flashing  at the far right of the menu bar (when Claris Emailer is 
hidden), and

1 an arrow  in the In Box tab in the Browser

Reading messages
To read a message, choose In Box from the Window menu, select the message 
you want to read, and click View (or double-click the message). You see the 
message window for the current message.

This icon Shows that

You read the message

The message contains one or more enclosures

You replied to the message

3-35
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To go to the next or previous message, click the left or right arrow in the 
upper-left corner. (Press Option as you click an arrow to delete the current 
message and go to the next or previous message.) Or, hold the mouse down 
over an arrow to see a pop-up menu. 

Opening and moving enclosed files
If a message has an enclosure, you see the Enclosures list the first time you 
open the message. You can also show the Enclosures list at any time by 
choosing Toggle Mailer from the Edit menu or clicking the triangle above the 
message area. You can open an enclosure from Claris Emailer, or move it to 
a convenient location on your hard drive and open it there. You move an 
enclosure on the desktop, or by dragging it from the Enclosures list using 
Macintosh drag and drop.

3-39
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Click to show or hide the
recipient and Enclosures lists

Click to show the 
Internet addressing 
information (if the 
message contains no 
Internet header, this 
button is dimmed)
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Opening an enclosure in Claris Emailer
To open an enclosure, double-click it in the Enclosures list. Claris Emailer 
launches the application used to create the enclosure. 

Important Claris Emailer cannot open an enclosure by itself. To open an 
enclosure, you must have the application used to create that enclosure. 

Moving an enclosure on the desktop
Enclosures are automatically saved in the Downloads folder in the 
Claris Emailer folder. You can drag an enclosure from the Downloads 
folder to another location on the desktop. 

Tip To change the default folder where downloaded enclosures are saved, 
choose Preferences from the Setup menu, click the General tab, click Set, and 
then select a folder. See “Setting general preferences” on page A-2.

Moving an enclosure using Macintosh drag and drop
Follow this procedure to drag a message from the Enclosures list to a folder 
or disk on the desktop. See “Using Macintosh drag and drop” on page 2-8.

1. Open the Enclosures list for an incoming message.

2. On the desktop, set up the windows so that you can see both the 
Enclosures list and the folder or disk into which you want to move 
the enclosure.

3. Select one or more enclosures in the Enclosures list.

Shift-click the enclosures you want to select. To deselect an enclosure, or 
to select noncontiguous enclosures, 2-click the enclosures.

4. Drag the enclosures to the desired folder or disk on the desktop.

Replying to a message
To reply to a message:

1. From the In Box, open the message you want to reply to. 

2. Click Reply or choose Reply from the Mail menu.

If there is more than one recipient, select an addressing option in the 
Reply To dialog box, and click Reply. 

Tip While you’re still in the message, press Option as you click Reply to 
bypass the Reply To dialog box.
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In your reply, you can add and remove recipients as you do for a message 
you create. For information, see “Addressing messages” on page 3-3.

Including text from the original message
You may want to include part of the original message in your reply, 
especially if:

1 there is a long delay between the original message and the reply

1 you want your reply to be seen in the context of the original message

1 one or more recipients did not receive the original message

Claris Emailer has a quoting feature you can use to mark the text of an 
original message in a reply. Every line of a quote is preceded by a quoting 
character (>).

Use one of the following methods to add a quote to a reply: 

To Open

Use text from an original 
message in a reply

The original message, select the text that you want to include 
in the reply, and then create the reply. For information on 
creating a reply, see the previous section.

Copy text from a message 
(or any other type of 
document) and then paste it 
into another message

A message or other document containing text, and copy the 
text you want to quote. Then position the insertion point in the 
reply and choose Paste as Quotation from the Edit menu.

Copy the entire body of a 
message, including details 
about the sender and subject

A message, and then choose Copy Entire Message from the Edit 
menu. You can then paste the text into a reply, or any other 
document that accepts text.
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Forwarding a message
A message you forward contains the complete original message. You can 
edit the text of the forwarded message just as you would a new message.

To forward a message, open the message you want to forward and click 
Forward or choose Forward from the Mail menu. To address the message, see 
“Addressing messages” on page 3-3. 

Filing messages
You can file incoming and outgoing messages in folders in the 
Filing Cabinet. Filing messages helps you to organize your In Box and 
Out Box. 

To file a message, select it in the In Box or Out Box, and then click File. Or, 
if you hold the mouse down over the File button, you see a pop-up menu. 
Choose a folder from the menu to save the selected message in that folder. 
(Claris Emailer is preset to save the message in the folder shown in bold in 
the pop-up menu.)

In the Filing Cabinet, you can view and open filed messages. To open the 
Filing Cabinet, choose Filing Cabinet from the Window menu.

Important You cannot open enclosures in a filed message. To open an 
enclosure, move the message back to the In Box or Out Box. See the next 
section, and “Moving messages using Macintosh drag and drop” on page 3-17.

3-54

3-49

Click a folder to see the
messages it contains

Double-click 
a message 
to open it



Using Claris Emailer 3-17

Working with filed messages
You can select and delete messages, find text in a message, and move messages 
back to the In Box or Out Box or to a different folder in the Folder Name list. 

Moving messages using Macintosh drag and drop
You can drag messages from the Filing Cabinet to:

1 the In Box or Out Box (by dropping them on the In Box or Out Box tab)

1 another folder in the Folder Name list 

1 a folder or disk on the desktop

See “Using Macintosh drag and drop” on page 2-8.

Note You cannot drag incoming messages to the Out Box or outgoing 
messages to the In Box.

Setting up folders in the Filing Cabinet
You can add and delete folders, and delete all the messages in a folder. 

To Do this

Select a message Click anywhere on the message. Shift-click to select 
more than one message. To deselect a message or to 
select noncontiguous messages, 2-click the messages.

Delete selected messages Click Delete File(s).

Find text in a message Click Find. In the dialog box, type the text you want to 
search for, select where you want to search, and click OK. 

Move selected messages to the 
In Box or Out Box

Hold the mouse down over the Move File(s) button, and 
choose In/Out Box from the pop-up menu. 

Move selected messages to another 
folder in the Folder Name list

Click Move File(s). In the dialog box, select the folder 
you want to move the messages to, and click OK.

To Do this

Add a folder to the Folder 
Name list

Click Add Folder and then type a name for the folder. 

You can add as many folders as you want to the Filing Cabinet. 
When you name a folder, use a meaningful name, such as 
“Project Status Messages.” 

Delete all the messages in 
a folder

Select the folder and click Empty Folder. 

You can empty only the Read Mail, Sent Mail, and Deleted 
Mail folders. 

Delete a folder Select the folder and click Delete Folder.

You can only delete folders you’ve added to the Filing Cabinet.
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The folders in the Filing Cabinet are stored on the desktop. Any folders you 
add to the Filing Cabinet go in the Personal Folders.

Tip If you file a message in a folder, or drag it to the desktop, you can open 
the message by double-clicking it.

Printing messages
This section covers printing incoming, outgoing, and saved messages. You 
can print one message at a time, and you must open a message to print it. 

If you want to change the page setup before you print—for example, to 
change the page orientation or size—choose Page Setup from the File menu. 
Then choose your options and click OK.

Note To change the default options in the Page Setup dialog box, choose 
Preferences from the Setup menu, click General, and then click Default Page 
Setup. Then choose your options and click OK. For more information, see 
appendix A, “Setting preferences.”

To print a message, open the message from the In Box, Out Box, or 
Filing Cabinet, and then choose Print from the File menu. (In an incoming 
message, you can also click the Print button.) In the Print dialog box, select 
the options you want, and click Print. 

To bypass the Print dialog box and print a message, choose Print One from 
the File menu. Your message prints using the default print settings.
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Chapter 4: Using the Address Book

 

Use the Address Book to store addresses. You can add addresses to the Address 
Book and set up group addresses. You can also import and export addresses to 
and from other applications and text files. When you’re finished adding 
addresses, you can find an address quickly by typing text in the 

 

Filter

 

 text box. 

After you add addresses to the Address Book, you can use them to address 
outgoing messages. See “Addressing messages” on page 3-3.

 

Adding addresses

 

You add addresses to the Address Book by either typing them manually or 
by adding the sender or recipient addresses from messages you receive. You 
can also exchange addresses with other people by saving them as text 
clippings. For more information about text clippings, see “Using Macintosh 
drag and drop” on page 2-8.

 

Important

 

You enter addresses differently depending on the recipient’s 
destination. To avoid addressing errors: 

 

If this is your 
destination

Enter this for the 
recipient’s address Example

 

Internet The full Internet address BAddington@aol.com

Any other destination The user’s address only BAddington

4-01

Individual address

Group address

Address with more than one mail
service (click the arrow to show or hide

additional addresses)
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Adding addresses manually

 

To add an address manually to the Address Book:

 

1.

 

Choose 

 

Address Book

 

 from the Window menu.

 

2.

 

Click 

 

New User

 

. 

 

3.

 

Enter a name and description for the recipient.

 

4.

 

For Destination, type the name of the service that the recipient uses to 
retrieve mail. 

For example, type

 

 America Online 

 

if the recipient receives mail in an 
America Online account. 

As you type, Claris Emailer fills in the rest of the destination for you. Keep 
typing until Claris Emailer fills in the correct destination. (If you want, you 
can choose a destination from the pop-up menu instead of typing.) 

If the destination does not appear in the pop-up menu, choose 

 

Internet

 

 and 
add the recipient’s full Internet address. (To add a destination to the pop-
up menu, see “Routing your mail using Destinations” on page 6-13.)

 

5.

 

Enter the mail address in the Address field.

 

6.

 

If the recipient has more than one mail address, click the  icon to add 
another address line, and then repeat steps 4 and 5. 

Continue adding lines until you’ve added all of the recipient’s addresses.

 

Note

 

To delete one of the recipient’s addresses, click anywhere in the 
address line and click the  icon.

 

7.

 

Click in the  column next to the address that you want to be the 
preferred address. 

4-03
Type the recipient’s
first and last names

The description can be a company 
name, a category (such as Friend 
or Family), or anything else you 
want
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Claris Emailer uses the preferred address when addressing a message.

 

8.

 

Click 

 

Save

 

.

 

Adding a sender or recipient address from an incoming message

 

To add a sender or recipient from an incoming message to your Address Book:

 

1.

 

Choose 

 

In Box

 

 from the Window menu.

 

2.

 

Select the message containing the address you want to add, and click 

 

View

 

.

 

3.

 

Choose 

 

Toggle Mailer

 

 from the Edit menu.

 

4.

 

Click the  button to the left of the sender’s name or to the right of the 
recipient’s name.

 

5.

 

In the dialog box, edit the name and add a description, if necessary.

If the 

 

Name

 

 and/or 

 

Description

 

 text boxes are blank, enter text for them.

 

6.

 

Click 

 

Save

 

.

 

Dragging addresses to the desktop

 

You can drag addresses and groups from the Address Book to the desktop, 
where they become text clippings. See “Using Macintosh drag and drop” on 
page 2-8. Later, you can drag a text clipping to an outgoing message (see 
“Addressing messages using Macintosh drag and drop” on page 3-5), or to a 
group (see “Creating groups” on page 4-4). 
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To drag addresses to the desktop:

 

1.

 

Choose 

 

Address Book

 

 from the Window menu.

 

2.

 

Arrange the windows so that you can see the Address Book and the desktop.

 

3.

 

Select one or more addresses from the Address Book. 

Shift-click to select more than one recipient. To deselect a recipient, or to 
select noncontiguous recipients, 

 

2

 

-click the recipients.

 

4.

 

Drag the addresses from the Address Book to the desktop.

The addresses become text clippings.

 

Creating groups

 

You can consolidate several recipient addresses into a group. When you send 
a message to a group, every recipient in the group receives the message.

 

Note

 

Addresses you add to a group are not linked to individual addresses in 
your Address Book. If you edit individual addresses, they do not change the 
addresses in any group. To edit addresses in a group, you must select the 
group, click 

 

Edit

 

, and make the changes there.

To create a group:

 

1.

 

Choose 

 

Address Book

 

 from the Window menu.

 

2.

 

Click 

 

New Group

 

. 

 

3.

 

In the Address Book Group Entry dialog box, enter a group name 
and description.

 

4.

 

Follow the instructions in the next section for adding addresses to a group.

 

5.

 

Click 

 

Save

 

.
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Adding addresses to a group

 

You can add addresses to a group by typing them manually, or by dragging 
them to the Address Book Group Entry dialog box using Macintosh drag and 
drop. You can drag addresses from the Address Book, or from the desktop.

 

Adding group addresses manually

 

To type addresses directly into Address Book Group Entry dialog box:

 

1.

 

Choose 

 

Address Book

 

 from the Window menu.

 

2.

 

Select the group to which you want to add addresses, and click 

 

Edit

 

.

 

3.

 

Enter the first and last name of a recipient in the User Name column.

 

4.

 

Enter the recipient’s mail address in the Address column.

 

5.

 

For Destination, enter the service that the recipient uses to retrieve mail. 

For example, type 

 

America Online

 

 if the recipient receives mail 
through an America Online account.

As you type, Claris Emailer fills in the rest of the destination for you. Keep 
typing until Claris Emailer fills in the correct destination. (If you want, you 
can choose a destination from the pop-up menu instead of typing). 

If the destination does not appear in the pop-up menu, choose 

 

Internet

 

 and 
add the recipient’s full Internet address. (To add a destination to the pop-
up menu, see “Routing your mail using Destinations” on page 6-13.)

 

6.

 

For additional recipients, click the  icon and then repeat steps 3 - 6. 

 

Dragging addresses from the Address Book to a group

 

Follow these steps to drag addresses from the Address Book to a group. See 
“Using Macintosh drag and drop” on page 2-8. 

 

1.

 

Choose 

 

Address Book

 

 from the Window menu.

 

2.

 

Select the group to which you want to add addresses, and click 

 

Edit

 

.

 

3.

 

Arrange the windows so that you can see both the Address Book and the 
Address Book Group Entry dialog boxes. 

 

4.

 

In the Address Book, select the recipients you want to add to the group.

Shift-click to select more than one recipient. To deselect a recipient, or to 
select noncontiguous recipients, 

 

2

 

-click the recipients.

 

5.

 

Drag the selected addresses from the Address Book to the Address Book 
Group Entry dialog box.

As you drag the addresses into the Address Book Group Entry dialog box, 
you see a border around the address area. When you release the mouse, 
the recipients are added to the group.
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Dragging addresses from the desktop to a group

 

If you drag addresses to the desktop (see “Dragging addresses to the 
desktop” on page 4-3), they become text clippings you can drag from the 
desktop to the Address Book Group Entry dialog box. For information about 
text clippings, see “Using Macintosh drag and drop” on page 2-8.

Follow these steps to drag addresses from the desktop to the Address Book 
Group Entry dialog box:

 

1.

 

Choose 

 

Address Book

 

 from the Window menu.

 

2.

 

Select the group to which you want to add addresses, and click 

 

Edit

 

.

 

3.

 

Arrange the windows so that you can see the Address Book Group Entry 
dialog box and the desktop.

 

4.

 

On the desktop, select the text clippings containing the addresses you 
want to add to your message. 

 

5.

 

Drag the text clippings from the desktop to the address area of the message. 

You see a border around the address area. When you release the mouse, 
the recipients are added to the group.

 

Removing addresses from a group

 

To remove an address from a group, open the Address Book Group Entry 
dialog box, click anywhere in the address line, and click the  icon.

 

Note

 

Removing an address from a group does not delete it from the 
Address Book. 
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Deleting an address or group

 

To delete an address or group permanently from the Address Book, choose 

 

Address Book

 

 from the Window menu, select the address or group that you 
want to delete and click 

 

Delete

 

.

Claris Emailer asks you to confirm the deletion.

 

Tip

 

Press Option as you click 

 

Delete

 

 to bypass the confirmation dialog box 
and delete the address. 

 

Importing addresses

 

You can import addresses into your Claris Emailer Address Book from 
another mail program, or from a tab-delimited text file.

 

Importing addresses from another mail application

 

If you have addresses in one of the following mail programs, you can import 
them directly into Claris Emailer.

To import addresses from another mail program, choose 

 

Import Addresses

 

 
from the File menu, find the file you want to import, and click 

 

Open

 

. 

 

Mail program Address book filename Location

 

America Online Address Book Online Tools folder in AOL folder

CompuServe 
Information 
Manager

CompuServe Addresses CompuServe folder in System 
Preferences folder

Eudora Eudora Nicknames Eudora Folder in System Folder

eWorld Address Book Online Tools folder in eWorld folder

Navigator CompuServe Addresses Navigator folder
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Importing addresses from a text file

 

If your addresses are not in one of the mail applications listed in the previous 
section, you can import them from a tab-delimited text file. 

 

Setting up the text file

 

At a minimum, your text file should include fields for the following four 
types of data (in this order): first name, last name, company, and address. If 
necessary, include additional address fields for recipients who subscribe to 
more than one mail service.

 

Note

 

If your text file includes full Internet addresses, Claris Emailer 
automatically chooses the correct destination for those addresses. For 
example, Claris Emailer automatically chooses 

 

eWorld

 

 as the destination for 
the address 

 

DanielleB@eworld.com. If the destination for an imported 
address isn’t in the Destinations List, Claris Emailer chooses Internet as the 
destination. (See “Routing your mail using Destinations” on page 6-13.)

If you’ve organized your addresses by service, you may want to add a 
header, and import the user names without the full Internet address. For 
example, your text file could have a header for America Online, and contain 
addresses like BAddington instead of BAddington@aol.com.

Note Be sure to include data in every field, or if there’s no data in a field, add 
a tab character for that field.

Importing the addresses
Follow these steps to import addresses from a text file:

1. Open Claris Emailer and choose Import Addresses from the File menu.
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2. In the Open dialog box, find the file you want to import and click Open. 

3. In the Import Addresses dialog box, select Ignore first record if the text file 
contains a header.

4. If necessary, choose options from the service pop-up menus to tell 
Claris Emailer how to import your data.

 

Choose To

Skip Field Ignore the field and not import it. 

For example, you can choose this option if a field is blank, or contains 
phone numbers or other data you don’t need to import.

No Service Import the address without specifying the service. (Later, you can go 
to the Address Book and specify a service for each imported address.)

A service name Select that service for the field

4-08
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5. Click  and  to preview records to make sure the preview data 
corresponds to the correct Address Book fields.

If the file is not properly formatted (for example, if the last name appears 
in the first name line), click Cancel and create a new import file.

Note If a line doesn’t have an address, that line is not imported.

6. Click Import.

Exporting addresses
To export the addresses from your Address Book to a text file, choose 
Export Addresses from the File menu, type a name and choose a location for the 
export file, and click Save.

Selecting addresses in the Address Book
You can select addresses in the Address Book and add them to messages. (See 
“Creating messages” on page 3-2 and “Addressing messages” on page 3-3.)

To narrow down the number of addresses in the Address Book, type a few 
letters in the Filter text box.

To select Do this

An address Click anywhere on the address row.

More than 
one address

Shift-click the addresses you want to select. To deselect an address, or 
to select noncontiguous addresses, 2-click the addresses.

The address above 
or below the 
currently selected 
address

Press the Up or Down Arrow key.

Every address in the 
Address Book

Choose Select All from the Edit menu.

A different 
destination for 
an address

Click the triangle next to the recipient’s name to display other 
destinations for the recipient. Then select the row containing the 
destination you want. 
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You can type lowercase or uppercase letters. Claris Emailer finds all the 
recipients that contain the specified letters in the Name and Description 
fields. For example, typing ja finds “Japan University” and “Jane Smith.”

Note You cannot enter part of a first name and a last name to create a match. 
For example, entering sal will doesn’t find “Sally Willford.”
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Chapter 5: Using mail actions

 

This chapter explains how to organize and manage your incoming mail by 
using 

 

mail actions

 

. When you receive a message, you can automatically 
prioritize it, file it in a folder, send a reply, or forward the message.

You can use mail actions in several ways. For example, you can:

 

1

 

place important messages at the top of your In Box when you sort it 
by priority

 

1

 

file incoming messages from certain people or groups in different folders

 

1

 

automatically send a return message saying you are away for awhile, such 
as when you are on vacation

 

1

 

automatically forward messages from all of your accounts to a single 
account, such as when you travel

 

Creating or changing mail actions

 

Mail actions compare areas of a received message with a word or phrase that 
you enter. When a comparison tests true, the actions you select occur. For 
example, you could create a mail action to test if the subject of a message 
contains 

 

Project X

 

. If it does, then the mail action could automatically 
prioritize the message so that it appears at the top of your In Box. You could 
also send an automatic reply saying that you received the message. 

You can create several different mail actions and turn them on and off as needed.

To create or change a mail action:

 

1.

 

Choose 

 

Mail Actions

 

 from the Setup menu.

You see the Mail Actions List window.
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2.

 

Click 

 

Add

 

 to create a new action. To change an existing mail action, 
double-click the mail action name.

You see the Mail Action Entry dialog box.

 

3.

 

Type a name for the mail action.

It’s a good idea to name the mail action so it is easily recognizable. For 
example, an action named 

 

Project X

 

 might file all project-related mail in 
a special folder.

 

4.

 

In the Criteria area, set the criteria to make the mail action occur.

For information on setting criteria, see “Setting mail action criteria” on 
page 5-4. 

 

5.

 

In the Actions area, set the actions to occur when the message meets 
the criteria.
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For information on setting actions, see “Setting actions for criteria-met 
mail” on page 5-6. 

 

6.

 

Click 

 

Save

 

.

 

Ordering mail actions

 

The order of mail actions affects how your incoming messages are processed. 
Once a received message meets the criteria of a mail action, only that action 
occurs. No additional mail actions test the message. Be sure to move the most 
important actions or the ones you always want performed to the top of the list. 
For example, if you always want messages from your boss prioritized, you 
should probably move that mail action to the top of the list. 

To change the order of your mail actions, drag a mail action to a new place 
on the Mail Actions List. When you drag a mail action upwards, you see a 
heavy line over the line where the action will be placed. When you drag a 
mail action downwards, you see a heavy line underneath the line where the 
action will be placed.
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folder, and choose a folder
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Click to set a priority for
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Deleting a mail action

 

To delete a mail action, select the mail action to delete, and click 

 

Delete

 

.

 

Setting mail action criteria

 

A mail action tests each incoming message using the criteria you select. You 
can apply the criteria to different areas of a message. For example, you can 
test for the sender’s name or address, or even for words in the message itself. 
You can also set a second test to evaluate the message further.

 

1.

 

Choose the message area to test in the incoming message from the pop-up 
menu in the Criteria area of the Mail Action Entry dialog box.

You can apply a test to each of the following areas of a message.

 

2.

 

Choose the test condition to apply to the message from the pop-up menu 
in the Criteria area.

 

Choose To test

 

From The name or address of the message sender

To The name or address of the recipients

CC The name or address of a carbon copied (CC) recipient

Reply-to The name or address of the reply-to field. Use a reply-to 
field primarily in messages sent via the Internet

Any recipient The name or address of any recipient

Subject The subject of the message

Message body The text of the message

Mail account The specific account at an online service used to receive 
the mail

Mail service The online service used to receive the mail

All mail All incoming messages

 

Choose If the text

 

Is Must match exactly

Is not Must not match exactly

Begins with Begins with the text you enter

Does not begin with Does not begin with the text you enter 
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Note

 

You cannot apply some tests to all areas of a message. For example, 
the subject of a message cannot be in the Address Book.

 

3.

 

Type the text to compare against the message area in the blank text box.

 

Important

 

 Consider what text you use, as Claris Emailer looks for any text 
matching the criteria, regardless of case. For example, 

 

Sam

 

 tests true for both 

 

Sam

 

 and 

 

Samantha

 

. The most accurate tests use a mail address.

If a single test is not enough to identify the message accurately, you can add 
a second test. For example, when you receive mail containing 

 

Sam

 

 in the 
sender’s name, you could apply a second test to look for 

 

Project X

 

 in the 
subject line. If both tests that look for 

 

Sam

 

 and 

 

Project X

 

 are true, then you 
could set a high priority to the message and file it in a special folder. 

 

Ends with Ends with the text you enter

Does not end with Does not end with the text you enter

Contains Contains the text you enter

Does not contain Does not contain the text you enter

Is in address book Is in the Address Book. This test can only be applied to 
address fields. The sender can be an individual or part of 
an address group.

Is in specific group Is in a specific group. A pop-up menu allows you to 
choose the name of the group.

Is in any group Is in any group

 

Choose If the text
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You can connect two tests in the following ways.

 

Setting actions for criteria-met mail

 

When the mail action criteria is true for your message, you can have 
Claris Emailer:

 

1

 

assign a priority to the message 

 

1

 

file the message in a folder

 

1

 

create an automatic reply 

 

1

 

forward the message to one or more addresses

 

Note

 

Messages created by a mail action are saved in the Out Box. You can 
send these messages manually or using a schedule. If you’re away from your 
computer for a long time, be sure to create a schedule that sends the mail 
generated by your mail actions.

 

Assigning a priority

 

Assigning priorities to your mail helps you identify the importance of a 
message. You can sort messages with a higher priority so they appear at the top 
of the In Box. You can also show these messages in a different color. Priorities 
are set by choosing 

 

Preferences

 

 from the Setup menu. For information on 
setting priorities, see “Setting priorities preferences” on page A-5.

To set a priority automatically, click 

 

Set priority

 

 in the Actions area of the Mail 
Action Entry dialog box. Then, choose a priority from the pop-up menu.

 

Filing a message

 

Filing messages automatically can help you organize your incoming messages. 

When you automatically file messages, you’ll see a message called 

 

Auto-file 
Log 

 

in the In Box. The message tells you where Claris Emailer stored your 
automatically filed messages. To see an automatically filed message, 
double-click the message described in the Auto-file Log.

 

Choose If you want

 

Ignore To disable the second test

And Both the first and second tests to be true for the action to occur 

Or Either the first or second test to be true for the action to occur

Unless Both the first and second tests to be true for no action to occur
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To file a message automatically, click 

 

File message 

 

in the Actions area of the 
Mail Action Entry dialog box. Then, choose a folder from the pop-up menu.

The folders you see in the pop-up menu are within the Filing Cabinet. For 
more information on creating folders, see “Filing messages” on page 3-16.

 

Creating an automatic reply

 

You can have a mail action automatically send a reply to a received message. 
Automatic replies are most useful when you want to acknowledge recieved 
messages, but cannot respond to your mail.

To reply to a message automatically, select 

 

Auto reply to message, 

 

and click 

 

Edit reply.

 

You see the Mail Action Auto Reply dialog box.

 

1.

 

Type your reply.

If you quote the incoming text, you may want to separate it from the 
response by leaving at least one blank line in your reply.

 

2.

 

Optionally, choose one of the message quoting options from the Incoming 
Message Quoting pop-up menu.

 

Choose To

 

Do not quote message Not include the incoming message in the reply

Quote before reply Include and quote the incoming message before the reply text

Quote after reply Include and quote the incoming message after the reply text

5-15
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For more information on quoting text, see “Including text from the 
original message” on page 3-15.

 

3.

 

Click 

 

Save

 

.

 

Forwarding a message automatically

 

You can have a mail action automatically forward specific messages that you 
receive. Automatically forwarding a message helps you send important 
messages to other people when you’re away. For example, you could 
forward messages with 

 

Project X

 

 in the subject to a colleague while you are 
on vacation.

To forward a message automatically:

 

1.

 

Select 

 

Auto forward message

 

 in the dialog box, and click 

 

Forward to

 

.

 

2.

 

In the Mail Action Forwarding Recipients dialog box, enter the names of 
the recipients for the forwarded message. For more information on 
entering recipients, see “Addressing messages” on page 3-3.

 

3.

 

Click 

 

Save

 

.
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Chapter 6: Configuring Claris Emailer

 

This chapter provides step-by-step instructions for configuring Claris 
Emailer, which includes scheduling connections to services, modifying 
locations, changing service information, and routing your mail.

 

Scheduling account connections

 

You can automate when Claris Emailer sends and receives your mail by 
creating 

 

schedules

 

.

 

 

 

Schedules help you efficiently manage your computer 
and automate connections to online services. For example, you could create 
one schedule to check your mail often during the week and another to check 
only once a day on the weekends. 

 

Important

 

You must have your computer and modem on and the Claris 
Emailer application running for schedules to run. Schedules do not launch 
Claris Emailer.

 

Creating or changing a schedule

 

You can create several schedules to send and receive your mail. Schedules 
can help you control connections to different services at various times during 
the day. For example, you can retrieve your mail from one service once a 
day, but send mail to another service once an hour.

Claris Emailer staggers the connection times within the ten-minute intervals 
you can choose for a schedule. This random interval relieves peak 
congestion at online services, helping you avoid connection errors. 

 

Note

 

You might want to consider the monthly costs of connecting to your 
services when you create a schedule. For example, if you create a schedule 
to connect once every 30 minutes to a service, you’ll connect 1,440 times per 
month. At one minute per connection, you would accumulate 24 hours of 
connect time.
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To create or change a schedule:

 

1.

 

Choose 

 

Schedules

 

 from the Setup menu.

You see the Schedules List window.

 

2.

 

Click 

 

Add

 

 to create a schedule. To change an existing schedule, double-
click the name of the schedule.

You see the Schedule Entry dialog box. 

 

3.

 

Type the new or changed name of the schedule.

It’s a good idea to name the schedule so that it is easily recognizable. For 
example, you might name a schedule that retrieves mail from America 
Online, 

 

AOL Mail

 

.
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4.

 

Select the tasks to perform during the connection. You can select 

 

Get Mail

 

 
or 

 

Send Mail

 

, or both.

 

Note

 

If you want to get your mail at one time and send it at another, you’ll 
need to create a schedule for each task.

 

5.

 

Select the account(s) that you want to make a scheduled connection to. 
You see a  next to each selected account.

You can connect to several accounts with one schedule. To disable an 
account without removing it from the schedule, deselect it.

 

Important

 

Changing how you connect to an account does not change a 
schedule; the schedule still runs, but using the connection information 
selected in the Service Entry dialog box. Likewise, if you select a 
different location in the Locations List window, be sure that the schedules 
you create for an account are still valid for the new location. For more 
information, see “Selecting locations” on page 6-5 and “Changing service 
information” on page 6-6.

 

6.

 

Choose either a timed or repeating connection from the Schedule Type 
pop-up menu.

If you choose a timed connection, select the days, hours, and times that 
you want the schedule to run. You must select at least one day, hour, and 
time

 

 

 

to activate the schedule.

If you choose a repeating connection, choose how often the schedule will 
run from the Frequency pop-up menu.

 

Note

 

The scheduling options in the Schedule Entry dialog box change 
when you select either a timed or repeating connection from the Schedule 
Type pop-up menu.

 

7.

 

Click 

 

Save

 

.

 

Deleting a schedule

 

To delete a schedule, choose 

 

Schedules

 

 from the Setup menu, select the 
schedule you want to delete, and click 

 

Delete

 

.
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Changing Locations settings

 

If you use Claris Emailer on a PowerBook and travel to different places, you 
may need to change your connection information as you change locales. To 
do this, use 

 

locations

 

. When you create locations in Claris Emailer, you can 
then quickly change connection information at any time. You do this by 
selecting a new location in the Locations List window.

 

Note

 

If you do not use Claris Emailer in multiple locations or have a need 
to change any connection information, then you probably don’t need to 
use locations. 

 

Creating or changing locations

 

You should create a location for each place where you plan to use Claris 
Emailer that requires different connection information. You can also use 
locations to change connection information, such as the baud rate for your 
modem, even if you do not travel with Claris Emailer. 

To create or change a location:

 

1.

 

Choose 

 

Locations

 

 from the Setup menu.

You see the Locations List window.

 

2.

 

Click 

 

Add 

 

to create a new location. Double-click the location name to 
change an existing location.

You see the Location Entry dialog box.

 

3.

 

Type the new or changed name of the location. For example, you could 
use the city name.

 

4.

 

Type the local three-digit area code number.

This area code helps you reference your location, but is not used when 
Claris Emailer dials a number.
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5.

 

For each service, choose the connection from the pop-up menu.

The connections in the pop-up menu were defined when you set up 
connection information for the service.

If a connection does not yet exist for the location, choose 

 

Edit Connections 

 

from the pop-up menu. You see the Service Entry dialog box. For 
information on creating or changing services, see “Changing service 
information” on page 6-6.

 

6.

 

Click 

 

Save

 

.

 

Selecting locations

 

When you select a location, you change the information Claris Emailer uses 
to connect to your online services.

To select a different location, click in the  column next to the new location.

 

Deleting locations

 

To delete a location, choose 

 

Locations

 

 from the Setup menu, select the 
location to delete, and click 

 

Delete

 

.
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Changing service information

 

When you installed Claris Emailer, you were asked to enter information about 
the services you use. When you change your accounts and connections, you’ll 
need to change that information in Claris Emailer as well.

You can also choose 

 

Easy Setup

 

 from the Setup menu to step through the 
initial setup screens if you use only one account per service. For more 
information on the initial setup screens, see “Installing Claris Emailer” on 
page 1-2.

For a list of services that you can connect to using Claris Emailer, choose 

 

Services

 

 from the Setup menu. You see the Services List window.

To edit your account and connection information, select the service to 
change, and click 

 

Edit

 

. See the next sections for information about 
changing each service.

When you add new connections, Claris Emailer copies the configuration 
information from the connection selected in the Connection list. For 
example, if you select the Main connection, and then click 

 

Add

 

, the 
configuration in the new, untitled connection is identical to Main. Select the 
new connection and change information as required.

 

Important

 

When you add a new service to Claris Emailer, be sure that 

 

Connect 
to this service

 

 in the Service Entry dialog box is selected. Otherwise, the 
service will not be available to use.
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Changing America Online information

 

To add or change the information for America Online, select 

 

America Online

 

 
in the Services List window, and then click 

 

Edit

 

. You see the Service Entry: 
America Online dialog box. When you’ve finished changing the 
information, click 

 

Done

 

. 

 

America Online connections

 

To add or change an America Online connection, click the 

 

Connections 

 

tab. 
You see the America Online connection information.

 

1.

 

To add a new connection, click 

 

Add

 

, and type the name of the 
new connection.

To change a connection, first click the connection. Then, select the text in 
the 

 

Connection name

 

 text box, and type the new name. 

 

2.

 

Click 

 

Configure

 

, and change the connection settings as needed. When 
you’re finished, click 

 

OK

 

.

 

3.

 

Choose the network you use from the pop-up menu.

 

4.

 

Click in the  column next to the connection you want used when 
connecting to America Online.
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America Online accounts

 

To add or change an America Online account, click the 

 

Accounts

 

 tab. You see 
the America Online account information.

 

1.

 

To add a new account, click a blank line.

To change an account, click the account name that you want to change.

You can enter up to five different America Online accounts.

 

2.

 

Type the account information in the text boxes. For descriptions of 
America Online account information, see “Setting up America Online 
and eWorld accounts” on page 1-5. You can type anything for the 
Account name, but the other text boxes must be valid for America Online.

 

3.

 

Click in the  column next to the account you want used when sending 
mail through America Online.

 

Changing CompuServe information

 

To add or change the information for CompuServe, select 

 

CompuServe 

 

in the 
Services List window, and then click 

 

Edit

 

. You see the Service Entry: 
CompuServe dialog box. When you’ve finished changing the information, 
click 

 

Done

 

. 
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CompuServe connections

 

To add or change a CompuServe connection, click the 

 

Connections 

 

tab. You 
see the CompuServe connection information.

 

1.

 

To add a new connection, click 

 

Add

 

, and type the name of the 
new connection.

To change a connection, first click the connection. Then, select the text in 
the 

 

Connection name

 

 text box, and type the new name.

 

2.

 

Type the connection information or choose the value from the pop-up 
menu for the field. For descriptions of standard CompuServe connection 
information, see “Setting up CompuServe accounts” on page 1-4.

 

3.

 

Click in the  column next to the connection you want used when 
connecting to CompuServe.
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CompuServe accounts

 

To add or change a CompuServe account, click the 

 

Account

 

 tab. You see the 
CompuServe account information.

 

1.

 

To add a new account, click a blank line.

To change an account, click the account name that you want to change. 

You can enter up to five different CompuServe accounts.

 

2.

 

Type the account information in the text boxes. For descriptions of 
CompuServe account information, see “Setting up CompuServe 
accounts” on page 1-4. You can type anything for the Account name, but 
the other text boxes must be valid for CompuServe.

 

3.

 

Select 

 

Do not delete read mail

 

 if you do not want your mail deleted after 
Claris Emailer gathers it from CompuServe. Select 

 

Ignore surcharge 
warnings

 

 if you do not want Claris Emailer to warn you about surcharges 
you may incur.

 

4.

 

Click in the  column next to the account you want used when sending 
mail through CompuServe.
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Changing eWorld information 

 

To add or change the information for eWorld, select 

 

eWorld 

 

in the Services 
List window, and then click 

 

Edit

 

. You see the Service Entry: eWorld dialog 
box. When you’ve finished changing the information, click 

 

Done

 

. 

 

eWorld connections

 

To add or change an eWorld connection, click the 

 

Connections 

 

tab. You see 
the eWorld connection information.

 

1.

 

To add a new connection, click 

 

Add, and type the name of the 
new connection.

To change a connection, first click the connection. Then, double-click in 
the Connection name text box and type the new name.

2. Click Configure and change the connection information as needed. Then, 
click OK.

3. Choose the network you use from the pop-up menu.

4. Click in the  column next to the connection you want used when 
connecting to eWorld.
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eWorld accounts
To add or change an eWorld account, click the Accounts tab. You see the 
eWorld accounts information.

1. To add a new account, click a blank line. 

To change an account, click the account name that you want to change. 

You can enter up to five different eWorld accounts.

2. Type the account information in the text boxes. For descriptions of 
eWorld account information, see “Setting up America Online and eWorld 
accounts” on page 1-5. You can type anything for the Account name, but 
the other text boxes must be valid for eWorld.

3. Click in the  column next to the account you want used when sending 
mail through eWorld.

Changing Internet account and connection information
To add or change an Internet account, click Internet in the Services List window, 
and then click Edit. You see the Internet account and connection information.
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1. To add a new account, click a blank line. 

To change an account, click the account name that you want to change. 

You can enter up to five different Internet accounts.

2. Type the connection information in the text boxes. For descriptions of 
Internet account information, see “Setting up Internet accounts” on page 
1-4. You can type anything for the Account name, but the other text boxes 
must be valid for the Internet.

3. Click in the  column next to the account you want used when sending 
mail through the Internet.

4. Click Save.

Changing RadioMail account information
To change a RadioMail account:

1. Click RadioMail in the Service List window, and then click Edit.

You see the Service Entry: RadioMail dialog box.

2. Type the account information in the text boxes. For descriptions of RadioMail 
account information, see “Setting up RadioMail accounts” on page 1-5.

3. Click Save.

Routing your mail using Destinations
Claris Emailer routes your mail over the Internet. Because Internet 
addressing can be confusing, Claris Emailer lets you define shorter names 
for the address of your mail, called destinations. For example, 
applelink.apple.com is the Internet address for AppleLink. Destinations let 
you use AppleLink instead of the full Internet address. You’ll find it helpful 
to create destinations for the places you frequently send electronic mail.
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If you use more than one online service, Claris Emailer sends your mail 
through the service selected in the Default Send Via pop-up menu. You can 
override this default. Changing the Send Mail Via setting lets you send mail 
for some destinations through one service and send mail for other 
destinations through a different service. For example, you could route all of 
your mail through America Online except for mail addressed to AppleLink, 
which you could route through eWorld. 

Create destinations and change the Default Send Via and Send Mail Via 
settings in the Destinations List.

Setting the Default Send Via service 
Claris Emailer uses the service in the Default Send Via setting to send mail 
to destinations with Send Mail Via set to Default. 

If you use only one online service, you cannot change the default for both 
Send Mail Via and Default Send Via.

To select the default service used to send your mail:

1. Choose Destinations from the Setup menu.

You see the Destinations List window.

2. Choose the service to use from the Default Send Via pop-up menu.
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The names you use for destinations

The actual Internet address for the destination Choose the default service to use when sending mail

Each destination has a Send Mail Via pop-up menu
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Changing the online service used for a specific destination
Change the Send Mail Via setting when you want mail addressed to a 
destination to go through a service other than the default.

If you use only one online service, all of your mail is routed through that service. 
You can only change the routing when you use more than one online service.

To change the service used to send mail to a specific destination:

1. Choose Destinations from the Setup menu.

You see the Destinations List window.

2. Choose the service to use when sending your mail to a specific destination 
from the Send Mail Via pop-up menu.

Adding or changing a destination
You can add or change destinations for the mail you send to any address.

Note You should not change destination information for America Online, 
CompuServe, eWorld, the Internet, or RadioMail.

To add or change a destination:

1. Choose Destinations from the Setup menu.

You see the Destinations List window.

2. To add a new destination, click Add. To change an existing destination, 
double-click the destination name. 

You see the Destination Entry dialog box.

3. Type the name of the destination.

4. Choose the service to use for this destination from the Send Mail Via 
pop-up menu.

You can also change the Send Mail Via setting later in the Destinations 
List window.

Choose Default in the Send Mail Via pop-up menu if you connect only to 
one service.
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5. Type the Internet address for the destination in the Internet domain name 
text box.

The Internet domain name should not contain the @ symbol. For 
example, eworld.com is the domain name for eWorld accounts.

6. Click Save.

Deleting a destination
When you delete a destination, be sure to change your Address Book as well. 
If an address in the Address Book uses the destination you delete, that 
address is no longer valid.

To delete a destination, select the destination you want deleted, and click Delete.

Note You cannot delete destinations for America Online, CompuServe, 
eWorld, the Internet, and RadioMail.



 

Appendix A: Setting preferences

 

You can use the Preferences dialog box to customize the way you work in 
Claris Emailer. For example, you can set Claris Emailer to connect when you 
launch the application, and file your mail after you read it. 

 

Opening the Preferences dialog box

 

To set preferences, choose 

 

Preferences

 

 from the Setup menu and click a tab. 
Then select the options you want and click 

 

OK

 

. For information on specific 
preferences, see the following sections.

 

Setting mail handling preferences

 

Select mail handling preferences to set where mail is stored, automatically 
delete mail after a specified number of days, and set how Claris Emailer 
alerts you about incoming mail.

 

To Do this

 

Set where Claris Emailer 
stores or files your messages

Choose options from the 

 

After reading a message

 

, 

 

After sending 
a message

 

, and 

 

After replying to a message 

 

pop-up menus.

Permanently delete mail 
you’ve read or sent after a 
specified number of days

Select 

 

Read mail folder

 

 or 

 

Sent mail folder

 

, and enter the number 
of days you want to keep messages before they’re deleted.
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Setting general preferences

 

Select general preferences to set defaults such as the area of the Browser you 
see when you start Claris Emailer, the font used for messages, and the 
location for downloaded enclosures. You can also set a preference to connect 
automatically to your online services when you start Claris Emailer. 

 

Delete mail permanently in 
your Deleted Mail folder 
after a specified amount 
of time

Select an option for Deleted Mail Folder. If necessary, enter 
the number of days you want to keep messages before they’re 
permanently deleted.

Claris Emailer keeps mail messages even after you delete 
them. Unless you throw them in the trash can or tell 
Claris Emailer to delete them automatically, deleted 
messages are kept in the Deleted Mail folder. See “Filing 
messages” on page 3-16.

Hear a tone when you 
receive messages

Select 

 

Play Sound

 

.

See a flashing  icon in 
the upper-right corner of the 
screen when you receive 
messages

Select 

 

Show icon in menu bar

 

.

(You see the icon when Claris Emailer is open, but not in the 
foreground.)

 

To Do this

 

Connect to a service every 
time you start Claris Emailer

Select 

 

Connect Using

 

. Then choose 

 

Connect Now

 

 to connect as 
you would if you chose 

 

Connect Now

 

 from the Setup menu. Or, 
choose a scheduled connection to connect immediately using 
the service and account settings in your scheduled connection.

Set which area of the 
Browser you see when 
you start Claris Emailer

Select 

 

Open Browser to,

 

 and then choose an option from the 
pop-up menu.

Compact the In Box and 
Out Box when you quit 
Claris Emailer

Select 

 

Compact mailboxes

 

. Then choose 

 

Always

 

 to compact the 
In Box and Out Box every time you quit Claris Emailer. Or, 
choose a numeric value to compact the In Box and Out Box 
when the free space in either the In Box or the Out Box 
exceeds a specific size.

(When you delete messages, Claris Emailer creates free space 
but does not reduce the size of the In Box and Out Box unless 
you set the 

 

Compact mailboxes

 

 preference.)

Set where enclosures you 
download are stored

Click 

 

Set

 

, select a folder or disk from the dialog box, and then 
click 

 

Select

 

.

 

To Do this
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Setting defaults preferences

 

Select defaults preferences to set the default options for the Reply and 
Connect Now Setup dialog boxes, the service used to send replies, and the 
date and time source for incoming messages. You can also set preferences to 
bypass certain dialog boxes, such as the dialog box that asks you to confirm 
message and address deletions. 

 

Tip

 

You can reverse the settings for bypassing or showing dialog boxes and 
alert messages by pressing Option each time you choose the command or 
select the button that opens the dialog box or alert message. For example, if 
you select the preference to bypass the Connect Now Setup dialog box, you 
can show the Connect Now Setup dialog box by pressing Option as you click 
the 

 

Send Now

 

 button in an outgoing message. 

 

Set the default font and font 
size for messages

Choose a font from the Font menu, and choose a font size 
from the Size menu. 

It’s best to choose a monospaced font, such as 

 

Monaco

 

 or 

 

Courier

 

, because most mail messages are formatted using 
monospaced fonts. You can also use spaces to line up 
columns of text with a monospaced font. 

The font and font size you choose are used in the body of both 
incoming and outgoing messages. 

Set the text color for quotes 
in incoming messages 

Click the sample color box for Quoting Color. Then select 
options from the dialog box for setting colors. See “Selecting 
a color” on page A-5.

Set the default options for 
the Page Setup dialog box

Click 

 

Default Page Setup

 

, select the options you want the 
Page Setup dialog box to default to, and then click 

 

OK

 

.

 

To Select

 

Show or bypass the 
Reply To dialog box you see 
when you reply to a message

Or deselect

 

 Prompt

 

 in the When Replying to Messages area.

To set which option is selected by default in the Reply To 
dialog box, select 

 

Reply to sender

 

 or 

 

Reply to sender and all 
other recipients

 

.

Set the default service used 
to send replies

 

Send via account that received mail 

 

to send replies via the service 
used to retrieve the original message, or select 

 

Use default send 
via 

 

to send replies via the default service in the Destinations List.

For information about setting the default service in the 
Destinations List, see “Routing your mail using Destinations” 
on page 6-13.

 

To Do this
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Setting signature preferences

 

Select signature preferences to set up closing information for your outgoing 
messages. A signature generally includes your name, company name, and 
mail address. Some signatures also include a phone number.

 

Show or bypass the Connect 
Now Setup dialog box you 
see when you choose 

 

Connect Now 

 

from the 
Mail menu

Or deselect

 

 Prompt

 

 in the When Clicking Send Now 
Button area.

To set which option is selected by default in the Connect Now 
Setup dialog box, select 

 

Send message 

 

or 

 

Send message and get 
waiting mail

 

.

Show or bypass the dialog 
box you see when you delete 
messages or addresses

Or deselect

 

 Prompt for deletions

 

.

If you deselect this option, and then delete a message or 
address, you cannot cancel or undo the action. 

Show or bypass the dialog 
box you see when you cancel 
a message you haven’t 
saved, or cancel the changes 
to a message you’ve saved

Or deselect

 

 Prompt when cancelling messages

 

. 

If you deselect this option and then cancel a message, you 
permanently discard the message (or changes to the message), 
and cannot undo the action.

Set the source of the date and 
time for incoming messages

Or deselect

 

 Use sender’s date/time for received mail

 

. 

Select this option to show the date and time that the sender 
sent the message. Deselect this option to show the date and 
time that Claris Emailer retrieved the message. 

Show or bypass the dialog 
box you see when you save 
an outgoing message that 
has no subject

Or deselect

 

 Prompt when message has no subject

 

Show or bypass the dialog 
box you see when you save 
an outgoing message that 
has no body text

Or deselect

 

 Prompt when message has no body

 

To Do this

 

Use the signature in the 
Internet Configuration 
System

Select 

 

Use Internet Configuration System

 

. 

Select this option only if your system has the Internet 
Configuration System installed and configured for signatures.

If you deselect this option and select the 

 

Use signature 

 

option 
in a message, the message uses the signature you create in the 
Preferences dialog box. 

Automatically select the 

 

Use signature

 

 option when you 
create an outgoing message

Select 

 

Use signature by default

 

.

 

To Select
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Setting priorities preferences

 

Select priorities preferences to rename and set the color for the priority 
designations for incoming messages. (You see a message’s priority in the 
Priority column in the In Box.)

 

Selecting a color

 

Select options in this dialog box to set the color of quotes and priority 
designations.

 

Note

 

This dialog box may look different, depending on your system version 
and the number of colors your monitor can display. 

 

Create a signature Type text in the text area in the lower part of the dialog box.

A signature should be short and concise, and should include a 
blank line at the end to make it easier to reply to your messages.

 

To Do this

 

Set the color for a priority Click the sample color box next to the priority whose color 
you want to change. Then select options from the dialog box 
for setting colors (see the next section).

Rename a priority Type over its current name.

 

To Do this
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Enter values or click the arrows 
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for choosing a color



 

Appendix B: Troubleshooting

 

With all of the flexibility and capability provided by the Internet and online 
mail services, it is not uncommon to receive error messages occasionally. 
You can expect that your mail will sometimes generate an error at its 
destination, return to you as undeliverable, or even get lost.

Connection problems produce the most common errors. When a connection 
error occurs, you see an error log in the In Box. The log continues to 
accumulate any error messages until you open it. After that, a new error log 
contains only the errors you have not yet seen.

Claris Emailer shows you the error messages received from your online 
service. The most common resolution to an error message is merely to resend 
your mail or try to connect again. 

The following table describes common errors and suggested resolutions:

 

When this happens Do this

 

Messages are returned

 

1

 

Check that the message is properly addressed, and resend the message.

Modem does not connect

 

1

 

Turn the speaker on to hear if a connection attempt occurs.

 

1

 

Make sure the modem setting matches the type of modem you use. If your modem is not on 
the list, try using 

 

Hayes

 

.

 

1

 

Try a lower baud rate.
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Mail was not sent

 

1

 

Make sure that an account is selected in the Accounts list on the Connect Now or Schedule 
Entry dialog boxes. 

 

1

 

Include both a subject and message text. Some services require both.

 

1

 

Check that a connection occurred.

 

1

 

Check the addresses for the message. If you see an alert icon in the Out Box, an addressing 
problem occurred.

 

1

 

Make sure that 

 

Do Not Schedule

 

 on your Outbox Item is not selected.

 

1

 

Open the Service Entry dialog box for your service, and make sure 

 

Connect to this service

 

 
is selected.

 

1

 

Make sure that Claris Emailer is running. Scheduled connections with not occur otherwise.

 

1

 

Try choosing 

 

Connect Now

 

 from the Mail pop-up menu.

A connection error occurs and an 
alert icon appears on the In Box tab

 

1

 

View the error message in the In Box describing the connection error and take 
appropriate action.

Received an error message from 
an online service 

 

1

 

Seek assistance from the online service.

Connection won’t occur

 

1

 

Redial. Poor connections or bad lines often cause connection problems.

 

1

 

Check for missing phone prefixes, such as 9, in your connection information. Check your 
other connection information too.

 

1

 

Try again later. You are likely experiencing a technical problem or congestion with the online 
service or Internet.

 

1

 

Check your modem for proper operation. Try lowering your baud rate or using the Hayes 
compatible setting in your connection information.

 

1

 

Disable call waiting, usually by inserting 

 

*70 

 

before the number dialed.

A PowerBook won’t connect to 
a service

 

1

 

Select the appropriate modem tool (for example, Express Modem Tool) by clicking 

 

Configure

 

 
in the Service Entry dialog box.

A connection will not stop when 
clicking 

 

Stop

 

1

 

Wait for the connection to complete, and then end the connection. Some actions cannot stop 
because of interactions with the host computer.

Message was sent more than once

 

1

 

No action is required. Some services limit the number of recipients for a single message. The 
message was resent until all recipients received a copy.

Address Book destinations change

 

1

 

If you moved the Destinations file, return it to the Claris Emailer Files folder. If the file was 
deleted or is missing, update the addresses in your Address Book.

The dial-up Internet won’t work

 

1

 

Resolve with your Internet connection software. Claris Emailer has no control over dial-up 
connections with the Internet.

The Internet mail you send does 
not contain your name

 

1

 

Enter your name in 

 

User Name

 

 on the Internet Service Entry dialog box.

 

1

 

If you connect to an online service, add your name to your user profile.

 

When this happens Do this



 

Appendix C: Using Uniform Resource Locators (URLs)

 

Uniform Resource Locators (URLs) describe locations on the Internet, such 
as mail addresses.

In Claris Emailer, you can: 

 

1

 

convert addresses in the Address Book to URLs

 

1

 

use URLs to address outgoing mail messages

 

1

 

use URLs to add addresses to the Address Book 

You use the Macintosh drag-and-drop feature when working with URLs. See 
“Using Macintosh drag and drop” on page 2-8.

 

Tip

 

If your system has the Internet Configuration System installed, you can 

 

2

 

-click a URL from within Claris Emailer to open it in the appropriate 
application. For example, if you have installed an application such as 
Netscape, you can 

 

2

 

-click a World Wide Web address to open the 
World Wide Web browser.

 

Converting addresses in your Address Book 
to URLs

 

To convert addresses in the Address Book to URLs, select an address and drag 
it to the desktop, to the address area, or to the body of an outgoing message.

 

If you You create

 

Drag one or more addresses to 
the desktop

Desktop clippings containing URLs for each address

Drag more than one address to 
the address area or the body of an 
outgoing message

A list of URLs

Drag a group address to the 
address area or the body of an 
outgoing message

A list of URLs for that group

Drag a group address to 
the desktop

A single text clipping with all URLs for every address in 
the group
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You can send someone one or more addresses from your Address Book by 
selecting the addresses that you want to send, and dragging them to the body 
of an outgoing message. To send your entire Address Book, choose 

 

Address Book

 

 from the Window menu, choose 

 

Select All

 

 from the Edit menu, 
and then drag all your addresses to the body of an outgoing message. 

 

Using URLs to address outgoing mail messages

 

To use a URL to address an outgoing message, drag the URL to the address 
area of an outgoing message. If you drag more than one URL, an address is 
added for each URL.

 

Using URLs to add addresses to the 
Address Book

 

To use URLs to add addresses to the Address Book, drag the URLs from an 
incoming message or from the desktop to the Address Book. If you drag 
more than one URL, a group address is created.
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For messages

 

To Press

 

Activate the recipients tab

 

2

 

 - Shift - R

Activate the enclosures tab

 

2

 

 - Shift - E

Skip confirmation dialog Option-click button

See the next message

 

2 

 

- 

 

B

 

See the previous message

 

2 

 

- 

 

A

 

Delete and move to the next message 
(in the Filing Cabinet or In Box only)

 

2 

 

- Option - 

 

B

 

Delete and move to the previous 
message (in the Filing Cabinet or 
In Box only)

 

2 

 

- Option - 

 

A

 

Add recipients

 

2 

 

- Shift - plus sign

Delete recipients

 

2 

 

- Shift - minus sign

Cancel messages Esc or 

 

2

 

 -. (period)

 

For text

Tips

 

To Press

 

Select the line above the insertion point Shift - 

 

C

 

Select the line below the insertion point Shift - 

 

D

 

Move to the next word Option - 

 

B

 

Move to the previous word Option - 

 

A

 

Select to the beginning of the text Shift - Option - 

 

C

 

Select to the end of the text Shift - Option - 

 

D

 

Go to beginning of the text Control - Option - 

 

C

 

Go to end of the text Control - Option - 

 

D

 

To Do this

 

Copy instead of moving text 
when dragging

Hold down Option

Choose from a menu with  on 
a button

Hold the mouse down 
over the button

Show or hide areas marked with Press 

 

2 

 

- T

Place or remove a  in an item on 
a list

Press 

 

B

 

 or 

 

A

 

Select another item in a list Press 

 

C 

 

or 

 

D

 

Keyboard shortcuts

 

To see the keyboard shortcut for a button, press 

 

2

 

 for a few seconds. The text on the buttons you see 
change, showing the keyboard equivalent. While still holding 

 

2 

 

down, press the other key or click the 
mouse as indicated. 

The following tables provide some other keyboard shortcuts.



 

I-2

 

Index

 

A

 

Account information
America Online 1-5, 6-8
changing and adding 6-6
CompuServe 1-4, 6-10
eWorld 1-5, 6-12
Internet 1-4, 6-12
RadioMail 1-5, 6-13

Actions on received mail 5-6
Add Enclosure button 3-8
Add Sender or Recipient button 4-3
Adding

a signature to a message A-4
accounts 6-6—6-13
addresses to

a group 4-5
a message 3-3—3-6
the Address Book 4-1—4-3

destinations 6-15
enclosures to a message 3-7—3-9
folders to the Filing Cabinet 3-17
groups to the Address Book 4-4—
4-7

locations 6-4
mail actions 5-1
quotes to a reply 3-15
schedules 6-1
text to a message 3-2

Address Book
adding groups to 4-4—4-7
adding senders and recipients 
to 4-3

addressing messages with 3-3, 
3-5, 4-4

deleting addresses from 4-7
described 2-6
exporting 4-10
importing addresses into 4-7—
4-10

opening 2-1
previewing addresses to be 
imported 4-9

saving addresses in 4-1
selecting addresses in 4-10
using 4-1—4-11

Address fields, requirements for 
importing 4-8

Address icon 3-7
Addresses

 

See also

 

 Recipients
adding to the Address Book 4-1—
4-3

converting to Uniform Resource 
Locators (URLs) C-1

deleting 4-2, 4-7
dragging 2-8, 2-9, 3-5, 3-6, 4-3, 
4-4, 4-5, 4-6

email 3-3
exporting 4-10
finding 3-4
groups 4-4—4-7
importing 4-7—4-10
preferred 4-2
removing from a group 4-6
saving 4-1
selecting 3-4, 4-10
showing and hiding 3-2

Addressing messages
adding

addresses 3-3—3-6
signatures A-4

error, icon for 3-11
Alert, for incoming messages A-2
America Online

account information 1-5, 6-8
connection information 6-7
importing addresses from 4-7

Arrows, next or previous (incoming 
messages) 3-13

ASCII text files (enclosures) 3-7, 
3-14

Assigning priorities 5-6
Automatically

forwarding messages 5-8
replying to messages 5-7

Automating connections 6-1

 

B

 

BCC. 

 

See

 

 Blind carbon copies
Beep, for incoming messages A-2
BinHex encoding 3-9
Blind carbon copies 3-6

Body, message 3-2
Browser

navigating in 2-1, A-2
opening and closing 2-1
resizing columns in 2-2
sorting in 2-2

Buttons
Add Enclosure 3-8
Add Sender Or Recipient 4-3
Edit 4-5, 4-6
Find Enclosure 3-7

Bypassing dialog boxes and alert 
messages A-3

 

C

 

Canceling messages, bypassing the 
dialog box for A-4

Carbon copies 3-6
CC. 

 

See

 

 Carbon copies
Changing locations 6-4
Checkmark icon 3-11, 3-12
Choosing a service

Destination 3-3, 3-5, 6-14
Send Mail Via 3-4, 6-14

Claris customer assistance W-1
Claris Emailer

described W-1
error log B-1
folder contents 1-6
hardware requirements 1-1
initial setup 1-3—1-5
installing 1-2
package contents 1-1
quitting 1-6
starting 2-1
system requirements 1-1
troubleshooting B-1
using in different locations 6-4

Claris technical support W-1
Clippings. 

 

See

 

 Text clippings
Clock icon 3-11
Closing

a message A-4
the Browser 2-1
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Color wheel A-5
Colors

for priorities A-5
for quotes A-3
lightness A-5
saturation A-5
selecting A-5

Columns, resizing and sorting 2-2
Compacting messages A-2
Compressing files 3-9
CompuServe

account information 1-4, 6-10
connection information 6-9
importing addresses from 4-7

Confidential recipients. 

 

See

 

 Blind 
carbon copies

Connecting
bypassing the Connect Now Setup 
dialog box A-4

connection error log B-1
described 2-2
immediately 3-10
mail action tests 5-5
setting up and 3-1, 3-2
using schedules 6-1
when you start Claris Emailer A-2

Connection information
America Online 6-7
CompuServe 6-9
eWorld 6-11
Internet 6-12

Connection log B-1
Consolidating addresses in a 
group 4-4—4-7

Converting addresses to Uniform 
Resource Locators (URLs) C-1

Copying quotations 3-15
Courier font A-3
Criteria, mail actions 5-4
Customer assistance W-1

 

D

 

Date received (incoming 
messages) A-4

Default
dialog box options A-3
folder for enclosures A-2
font A-3

page setup A-3
service used 6-14
signature A-4

Deleted Mail folder A-2
Deleting

addresses and groups 3-3, 4-2, 4-7
addresses from a group 4-6
destinations 6-16
enclosures 3-9
folders in the Filing Cabinet 3-17
locations 6-5
mail actions 5-4
messages

bypassing the dialog box 
for A-4

in the Filing Cabinet 3-17, A-1
schedules 6-3

Description field 3-4
Desktop 3-6, 3-9, 3-14, 3-17, 4-4, 4-6
Destinations

adding or changing 2-4, 3-3, 3-5, 
4-2, 4-5, 4-10, 6-15

deleting 6-16
routing mail with 6-13

Dialog boxes, bypassing A-3
Do Not Schedule option 3-10, 3-11
Documents. 

 

See

 

 Files
Downloading enclosures 3-14, A-2
Dragging

addresses 2-8, 2-9, 3-5, 3-6, 4-3, 
4-4, 4-5, 4-6

enclosures 3-9, 3-14
mail actions 5-3
text from a message to the 
desktop 2-9

 

E

 

Edit button 4-5, 4-6
Electronic mail. 

 

See

 

 Messages
Email. 

 

See

 

 Messages
Emptying folders in the Filing 
Cabinet 3-17

Enclosing files
enclosure icon 3-7, 3-8, 3-11, 3-12
in an outgoing message 3-7—3-9

Enclosures
adding 3-7—3-9
default folder for A-2
deleting 3-9
downloading 3-13, 3-14, A-2

dragging
to a message 3-9
to the desktop 3-14

enclosure list, showing 3-13
filing A-2
finding 3-7, 3-8
opening 3-14
options for 3-9
viewing 3-13

Encoding compressed files 3-9
Enlarging columns 2-2
Entering addresses 3-2—3-5, 4-1—
4-3

Errors
icon for 3-11
receiving B-1

Eudora, importing addresses from 4-7
eWorld

account information 1-5, 6-12
connection information 6-11
importing addresses from 4-7

Exclamation point icon 3-11
Expanding compressed files 
(enclosures) 3-9

Exporting addresses 4-10

 

F

 

Fields, requirements for importing 
address 4-8

File formats for
enclosures 3-7, 3-14
importing addresses 4-7—4-8

Files
compressing 3-9
enclosure 3-7—3-9

Filing Cabinet
compressing messages in A-2
dragging and dropping messages 
in 3-17

filing messages
automatically 5-6, A-1
manually 2-8, 3-16—3-18

folders in 3-17, 3-18
opening 2-1, 3-16
saving mail in 3-16—3-17

Filling the Address Book 4-1—4-3
Filter text box 2-6, 3-4, 4-1, 4-10
Find Enclosure button 3-7
Finding



 

Index I-3

 

addresses 3-4
enclosures 3-7, 3-8
text in a message 3-17

Folders, in the Filing Cabinet 3-17, 
3-18

Font
color for priorities A-5
for messages A-3
for quotes A-3
monospaced A-3

Formats, file
for enclosures 3-7, 3-14
for importing addresses 4-7—4-8

Forwarding messages
automatically 5-8
manually 3-16

 

G

 

Getting messages. 

 

See

 

 Receiving 
messages

Groups
creating 4-4—4-7
deleting 4-7
removing addresses from 4-6
saving 4-4

 

H

 

Hardware requirements 1-1
Hiding

alert messages and dialog 
boxes A-3

enclosures 3-7
the address area (outgoing 
messages) 3-2

the enclosure and recipient lists 
(incoming messages) 3-13

Hue angle A-5

 

I, J, K

 

Icons
address 3-3, 3-7, 4-1
enclosure 3-7, 3-8, 3-9
for incoming messages 3-12, A-2
for text clippings 2-8
In Box 3-12
Out Box 3-11
plus sign 4-2, 4-5
preferred address 4-2

trash can 4-2, 4-6
Immediately sending a message 3-10
Importing addresses from

a text file 4-8
America Online, CompuServe, 
Eudora, eWorld, and 
Navigator 4-7

In Box 2-1, 3-12, 3-16, 3-17, 4-3
Including quotes in a reply 3-15
Incoming messages

addresses from, adding to the 
Address Book 4-3

beep for A-2
date and time received A-4
filing 3-16—3-18
forwarding 3-16
icons for 3-12, A-2
Internet header 3-13
replying to 3-14, 5-7
seeing a list of 3-12

Installing Claris Emailer 1-2—1-5
Internet

account information 1-4, 6-12
configuration system A-4
connection information 6-12
header, viewing 3-13
sending messages via 2-2, 2-4, 3-7
using short names 6-13

 

L

 

Lightness, color A-5
Lines in a text file 4-8
Locations

adding 6-4
changing connection 
information 6-5

creating and changing 6-4
deleting 6-5
editing connections 6-5
selecting 6-5

 

M

 

Macintosh drag and drop 1-6, 2-8, 
2-9, 3-5, 3-6, 3-9, 3-14, 3-17, 4-3, 
4-5, 4-6

Mail actions
adding second tests 5-5
assigning priorities 5-6
comparing text 5-5

creating and changing 5-1
creating automatic replies 5-7
deleting 5-4
described 2-5, 5-1
filing messages 5-6
forwarding messages 5-8
naming 5-2
ordering 5-3
prioritizing 5-3
setting criteria 5-4

Mail. 

 

See

 

 Messages
Messages

adding and removing 
enclosures 3-7—3-9, 3-13

addressing 3-3—3-6
automatically

forwarding 5-8
replying 5-7

compressing A-2
creating 3-2
date and time received A-4
default font A-3
deleting A-1
filing

automatically 5-6
manually 3-16—3-18, A-1

forwarding 3-16
opening from the desktop 2-1
pre-addressed 3-2
printing 3-18
prioritizing 5-6, A-5
quoting 3-15, A-3
reading 3-12
receiving 3-12—3-16
replying to 3-14
sending 3-10, 3-11
showing status of 3-11
signatures in A-4
testing 5-5
title 3-2
with no subject or body A-4

Modem 1-5, 2-2, 3-1
Monaco font A-3
Monospaced fonts A-3
Moving

addresses to
a group 4-5
a message 3-4, 3-5, 3-6
the desktop 4-3, 4-4

around in the Browser 2-1
enclosures 3-9, 3-13, 3-14
messages to folders 3-16—3-18, 
A-1
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N

 

Name, recipient 3-3, 3-4
Naming

destinations 6-13
groups 4-4
mail actions 5-2
messages 3-2
schedules 6-2

Navigating in Browser 2-1, A-2
Navigator, importing addresses 
from 4-7

Next message, viewing 3-13

 

O

 

Online services

 

See also

 

 Services
connecting to 3-1, 3-2
Destination 3-3, 3-5
Send Mail Via 3-4
setting up 6-6—6-13

Open dialog box 3-8
Opening

enclosures 3-14
filed messages 3-16
messages from the desktop 2-1
the Browser 2-1

Options
for enclosures 3-9
for starting Claris Emailer A-2

Ordering mail actions 5-3
Organizing mail. 

 

See

 

 Filing Cabinet
Orientation, page 3-18
Out Box 2-1, 3-2, 3-10, 3-11, 3-16, 
3-17

Outgoing messages
filing 3-16—3-18
icons for 3-11
sending 3-10, 3-11
status of 3-11

 

P

 

Page Setup dialog box 3-18, A-3
Page setup, default A-3
Page size and orientation 3-18
Paperclip icon 3-7, 3-8, 3-11, 3-12
Pasting quotations 3-15
Plus sign 4-2, 4-5

Pre-addressed messages 3-2
Preferences

Page Setup 3-18
setting A-1, ??—A-5
Startup Options 2-1

Preferred address 4-2
Previewing addresses to be 
imported 4-9

Previous message, viewing 3-13
Printing 2-7, 3-18, A-3
Prioritizing

incoming messages A-5
mail actions 5-3
received messages 5-6

Problems B-1
Purging messages A-2

 

Q

 

Quitting Claris Emailer 1-6
Quoting

a message 3-15
character (>) 3-15
color (incoming messages) A-3, 
A-5

in automatic replies 5-7

 

R

 

RadioMail, account information 1-5, 
6-13

Reading messages 3-12
Received messages. 

 

See

 

 Incoming 
messages

Receiving
enclosures 3-13
errors B-1
messages 2-4, 3-12—3-16

Recipient types
blind carbon copy (BCC) 3-6
carbon copy (CC) 3-6

Recipients

 

See also

 

 Addresses
adding to a message 3-3—3-6
finding 3-4
from an incoming message, adding 
to the Address Book 4-3

Reducing column size 2-2
Registering your software W-1

Removing
addresses from

a group 4-6
a message 3-3
the Address Book 4-7

enclosures 3-9
messages A-2
software 1-7

Renaming
priorities A-5
text clippings 2-8

Replying
automatically 5-7
bypassing the Reply To dialog 
box A-3

icon for 3-11, 3-12
to a message 3-14
with a quote 3-15

Resizing
columns 2-2
the address area 3-2

Retrieving messages 3-2
Returned messages B-1
Routing mail 6-13

 

S

 

Saturation, color A-5
Saving

 

See also

 

 Exporting addresses
addresses in the Address Book 4-3
groups 4-4
mail in Filing Cabinet 3-16—3-17
messages 3-10, 3-11, A-4

Schedules
creating or changing 6-1
deleting 6-3
naming 6-2
selecting accounts 6-3

Scheduling
account connections 6-1
outgoing messages 3-10

Searching for
addresses 3-4
enclosures 3-7, 3-8
text in a message 3-17

Selecting
a preferred address 4-2
addresses

in a message 3-4, 3-5
in the Address Book 4-5, 4-7, 
4-10, 4-11
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colors A-5
enclosures 3-8, 3-14
groups 4-5, 4-6
messages in the Filing 
Cabinet 3-17

services for destinations 6-14
Send Mail Via 2-4
Sender, adding to the Address 
Book 4-3

Sending
automatic replies 5-7
compressed files 3-9
enclosures 3-7—3-9
messages 2-3, 3-2, 3-10, 3-11
showing status 3-11

Service Default encoding 3-9
Services

 

See also

 

 Online services
changing and adding 6-6—6-13
described 1-3—1-5

Setting
options for enclosures 3-9
preferences A-1
the source for the receiving date 
and time A-4

Setting up
accounts 1-3—1-5, 6-6—6-13
connections 3-1, 3-2

Showing
addresses 2-1, 3-2
alert messages A-3
Browser 2-1
dialog boxes A-3
enclosures 3-7, 3-13
error messages B-1
filed messages 2-1, 3-16
incoming messages 2-1, 3-12
Internet header 3-13
outgoing messages 2-1
recipients 3-13
sending status 3-11
signatures in messages A-4
when a message is received A-4

Signatures 3-2, A-4
Size, page 3-18
Skipping dialog boxes and alert 
messages A-3

Software requirements 1-1
Sorting columns 2-2
Sound, for incoming messages A-2

Spaces, in message body, using to line 
up columns A-3

Starting Claris Emailer 2-1, A-2
Status, of messages you send 3-11
Storing

addresses 4-1
groups 4-4—4-7
messages, in folders 3-16, A-1

StuffIt 3-9

 

T

 

Technical support W-1
Test conditions, choosing 5-4
Testing messages 5-4, 5-5
Text

address, typing in
a group 4-5
a message 3-3
the Address Book 4-2

ASCII files (enclosures) 3-7
color for priorities A-5
color for quotes A-3
comparing in mail actions 5-5
font and size (message body) A-3
reading, in a message 3-12
signature A-5
tab-delimited 4-8
typing, in the message body 3-2

Text clippings 2-8, 3-5, 3-6, 4-3, 4-4, 
4-6

Time received (incoming 
messages) A-4

Title, message 3-2
Tone, audible, for incoming 
messages A-2

Trash can 4-2, 4-6
Troubleshooting B-1
Type, recipient 3-6
Typing

addresses in
a group 4-5
a message 3-3
the Address Book 4-2

signatures A-5
text in a message 3-2

 

U

 

Uniform Resource Locators 
(URLs) C-1

Users. 

 

See

 

 Addresses
Using text in a quote 3-15

 

V, W, X, Y, Z

 

Viewing
error messages B-1
filed messages 3-16
messages 3-12
recipients and enclosures 3-13


